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 Trang 1 

CHÖÔNG 1: GIÔÙI THIEÄU 

1.1 Giôùi thieäu PLC S7-300 

1.1.1 Thieát bò ñieàu khieån logic khaû trình. 

 Thieát bò ñieàu khieån logic khaû trình (Programmable Logic Controller) laø 

loaïi thieát bò thöïc hieän linh hoaït caùc thuaät toaùn ñieàu khieån soá thoâng qua moät 

ngoân ngöõ laäp trình, thay vì phaûi thöïc hieän thuaät toaùn ñoù baèng maïch soá. Nhö 

vaäy, PLC laø moät boä ñieàu khieån goïn, nheï vaø deã trao ñoåi thoâng tin vôùi moâi tröôøng 

beân ngoaøi (vôùi caùc PLC khaùc hoaëc maùy tính). Toaøn boä chöông trình ñieàu khieån 

ñöôïc löu tröõ trong boä nhôù cuûa PLC döôùi daïng caùc khoái chöông trình vaø ñöôïc 

thöïc hieän theo chu kyø cuûa voøng queùt (scan).  

 

 

 Ñeå thöïc hieän ñöôïc moät chöông trình ñieàu khieån, taát nhieân PLC phaûi coù 

tính naêng nhö moät maùy tính, nghóa laø phaûi coù moät boä vi xöû lyù (CPU), moät heä 

ñieàu haønh, boä nhôù ñeå löu chöông trình ñieàu khieån, döõ lieäu vaø taát nhieân phaûi coù 

caùc coång vaøo/ra ñeå giao tieáp ñöôïc vôùi ñoái töôïng ñieàu khieån vaø ñeå trao ñoåi 

Boä nhôù chöông trình 

Timer  

Bit côø 

Boä ñeám 

Boä xöû lyù trung taâm 

+ 

Heä ñieàu haønh 

Quaûn lyù keát noái 
Coång ngaét vaø 

ñeám toác ñoä cao 

Coång vaøo/ra 

onboard 

Bus cuûa PLC 

Hình1.1. Caáu truùc beân trong cuûa moät PLC 

 

Boä ñeäm 

vaøo/ra 

CPU 
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 Trang 2 

thoâng tin vôùi moâi tröôøng xung quanh. Beân caïnh ñoù nhaèm phuïc baøi toaùn ñieàu 

khieån soá, PLC coøn phaûi coù theâm moät soá khoái chöùc naêng ñaëc bieät khaùc nhö boä 

ñeám (Counter), boä ñònh thôøi (Timer) … vaø nhöõng khoái haøm chuyeân duøng. 

Öu ñieåm cuûa boä ñieàu khieån laäp trình ñöôïc so vôùi ñieàu khieån noái daây: 

 Tính naêng môû roäng: khaû naêng môû roäng xöû lyù baèng caùch thay ñoåi chöông 

trình laäp trình moät caùch deã daøng. 

 Ñoä tin caäy cao. 

 Caùch keát noái caùc thieát bò ñieàu khieån ñôn giaûn. 

 Hình daùng PLC goïn nheï. 

 Giaù thaønh vaø chi phí laép ñaët thaáp. 

 Phuø hôïp vôùi moâi tröôøng coâng nghieäp. 

Caùc öùng duïng cuûa PLC trong saûn xuaát vaø trong daân duïng: 

 Ñieàu khieån caùc Robot trong coâng nghieäp. 

 Heä thoáng xöû lyù nöôùc saïch. 

 Coâng ngheä thöïc phaåm. 

 Coâng ngheä cheá bieán daàu moû. 

 Coâng ngheä saûn xuaát vi maïch. 

 Ñieàu khieån caùc maùy coâng cuï. 

 Ñieàu khieån vaø giaùm saùt daây chuyeàn saûn xuaát. 

 Ñieàu khieån heä thoáng ñeøn giao thoâng. 

 … 

1.1.2 Caùc module cuûa PLC S7-300. 

 Ñeå taêng tính meàm deûo trong caùc öùng duïng thöïc teá maø ôû ñoù phaàn lôùn caùc 

ñoái töôïng ñieàu khieån coù soá tín hieäu ñaàu vaøo, ñaàu ra cuõng nhö chuûng loaïi tín 

hieäu vaøo/ra khaùc nhau maø caùc boä ñieàu khieån PLC ñöôïc thieát keá khoâng bò cöùng 

hoaù veà caáu hình. Chuùng ñöôïc chia nhoû thaønh caùc module. Soá caùc module ñöôïc 

söû duïng nhieàu hay ít tuyø thuoäc vaøo töøng baøi toaùn, song toái thieåu bao giôø cuõng coù 

module chính (module CPU, module nguoàn). Caùc module coøn laïi laø nhöõng 

module truyeàn nhaän tín hieäu vôùi caùc ñoái töôïng ñieàu khieån, chuùng ñöôïc goïi laø 

caùc module môû roäng. Taát caû caùc module ñeàu ñöôïc gaù treân moät thanh Rack. 

Module CPU: 
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 Trang 3 

 Ñaây laø loaïi module coù chöùa boä vi xöû lyù, heä ñieàu haønh, boä nhôù, caùc boä thôøi 

gian, boä ñeám, coång truyeàn thoâng,… vaø coù theå coù caùc coång vaøo/ra soá. Caùc coång 

vaøo/ra tích hôïp treân CPU goïi laø coång vaøo ra onboard. 

 Trong hoï PLC S7-300, caùc module CPU coù nhieàu loaïi vaø ñöôïc ñaët teân theo 

boä vi xöû lyù beân trong nhö : CPU 312, CPU 314, CPU 316,…. Nhöõng module 

cuøng moät boä vi xöû lyù nhöng khaùc nhau soá coång vaøo/ra onboard cuõng nhö caùc 

khoái haøm ñaëc bieät thì ñöôïc phaân bieät baèng cuïm chöõ caùi IFM (Intergrated 

Function Module). Ví duï nhö CPU 312IFM, CPU 314IFM,….  

 Ngoaøi ra, coøn coù loaïi module CPU coù hai coång truyeàn thoâng, trong ñoù 

coång thöù hai duøng ñeå noái maïng phaân taùn nhö maïng PROFIBUS (PROcess Field 

BUS). Loaïi naøy ñi keøm vôùi cuïm töø DP (Distributed Port) trong teân goïi. Ví duï 

module CPU315-DP. 

Module môû roäng: 

Caùc module môû roäng ñöôïc thaønh 5 loaïi : 

1) PS (Power Supply): module nguoàn laø module taïo ra nguoàn coù ñieän aùp 24Vdc 

caáp nguoàn cho caùc module khaùc. Coù 3 loaïi: 2A, 5A vaø 10A. 

 

 

 

 

 

 

        

 

 

 

 

             Ñeøn chæ thò nguoàn 24Vdc                                  ON/OFF Switch 24Vdc 

             Ñoâmino noái daây ngoõ ra ñieän aùp 24Vdc 

             Caàu chì baûo veä quaù doøng 

             Ñoâmino noái daây vôùi ñieän aùp 220Vac 

 Hình1.2. Sô ñoà khoái vaø sô ñoà ñaáu daây cuûa module nguoàn  

 PS307;2A (6ES7307-1BA00-0AB) 

1 
 

2 
 

3 
 

4 
 

1 
 

5 
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 Trang 4 

2) SM (Signal Module): Module môû roäng vaøo/ra, bao goàm : 

a) DI (Digital Input): module môû roäng coång vaøo soá. Soá caùc coång vaøo soá môû 

roäng coù theå laø 8, 16 hoaëc 32 tuyø thuoäc vaøo töøng loaïi module. 

 

 

 

 

 

 

 

 

 

 

 

             Soá thöù töï caùc ngoõ vaøo soá trong module                             

             Ñeøn chæ thò möùc logic 

             Bus beân trong cuûa module  

b) DO (Digital Output): module môû roäng coång ra soá. Soá caùc coång vaøo soá môû 

roäng coù theå laø 8, 16 hoaëc 32 tuyø thuoäc vaøo töøng loaïi module. 

 

 

 

 

 

 

 

 

 

2 
 

3 
 

1 
 

Hình 1.3.  Sô ñoà ñaáu daây cuûa module  

SM221; DI 32 x DC 24V    

  (6ES7321-1BL00-0AA0) 

Hình 1.4. Sô ñoà ñaáu daây cuûa module  

SM221; DI 32 x AC 120V    

  (6ES7321-1EL00-0AA0) 

Hình 1.6.  Sô ñoà ñaáu daây cuûa module  

SM 322; DO 16 x AC 120/230 V/1 A; 

(6ES7322-1FH00-0AA0) 

Hình 1.5.Sô ñoà ñaáu daây cuûa module  

SM 322; DO 32 x 24 VDC/ 0.5 A;  

  (6ES7322-1BL00-0AA0) 
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 Trang 5 

 

 

 

 

 

 

 

 

 

 

 

 

             Soá thöù töï caùc ngoõ vaøo soá trong module                             

             Ñeøn chæ thò möùc logic 

             Bus beân trong cuûa module  

c) DI/DO (Digital Input/Digital Output): module môû roäng coång vaøo/ra soá. 

Soá caùc coång vaøo/ra soá môû roäng coù theå laø 8 vaøo/8 ra hoaëc 16 vaøo/16 ra 

tuyø thuoäc vaøo töøng loaïi module. 

 

Soá thöù töï caùc ngoõ vaøo soá trong 

module                             

                    Ñeøn chæ thò möùc logic 

        Bus beân trong cuûa module  

 

 

 

 

 

 

Hình 1.7.  Sô ñoà ñaáu daây cuûa module  

SM 322; DO 16 x Rel. AC 120/230 V;   

     (6ES7322-1HH01-0AA0) 

 

Hình 1.8.  Sô ñoà ñaáu daây cuûa module  

  SM 322; DO 8 x Rel. AC 230V/5A;   

        (6ES7322-5HF00-0AB0) 

 

2 
 

3 
 

1 
 

Hình 1.9.  Sô ñoà ñaáu daây cuûa module  

SM 323; DI 16/DO 16 x DC 24 V/0.5 A; 

       (6ES7323-1BL00-0AA0) 

 

2 
 

3 
 

1 
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 Trang 6 

d) AI (Analog Input): module môû roäng coång vaøo töông töï. Baûn chaát chuùng 

laø nhöõng boä chuyeån ñoåi töông töï sang soá (ADC). Soá caùc coång vaøo töông 

töï coù theå laø 2, 4 hoaëc 8 tuyø töøng loaïi module, soá bit coù theå laø 

8,10,12,14,16 tuøy theo töøng loaïi module. 

Ví duï: Module SM 331; AI 2 x 12 bit; (6ES7331-7KB02-0AB0) 

Caùc daïng tín hieäu ñoïc ñöôïc 

- Ñieän aùp 

- Doøng ñieän 

- Ñieän trôû 

- Nhieät ñoä 

Ñoä phaân giaûi 12 bit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 1.10.   Sô ñoà ñaáu daây cuûa module  

Khi tín hieäu vaøo laø ñieän aùp 
Hình 1.11.   Sô ñoà ñaáu daây cuûa module  

Khi tín hieäu vaøo laø ñoøng ñieän 

Hình 1.12.   Sô ñoà ñaáu daây cuûa module  

Khi tín hieäu vaøo laø ñieän trôû 

Hình 1.13.  Sô ñoà ñaáu daây cuûa module  

Khi tín hieäu vaøo laø Thermocouple 
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e) AO (Analog Output): module môû roäng coång ra töông töï. Chuùng laø nhöõng 

boä chuyeån ñoåi töø soá sang töông töï (DAC). Soá coång ra töông töï coù theå laø 2 

hoaëc 4 tuyø töøng loaïi module. 

 

 

 

 

 

 

 

 

 

 

 

 

 

f) AI/AO (Analog Input/Analog Output): module môû roäng vaøo/ra töông töï. 

Soá caùc coång vaøo ra töông töï coù theå laø 4 vaøo/2 ra hoaëc 4 vaøo/4 ra tuyø töøng 

loaïi module. 

3) IM (Interface Module): Module keát noái.  

 

 

 

 

 

 

 

 

 

Hình 1.14.   Sô ñoà ñaáu daây cuûa module  

SM 332; AO 4 x 12 Bit; 

(6ES7332-5HD01-0AB0) 

 

Hình 1.15.   Sô ñoà ñaáu daây cuûa module  

IM 365; (6ES7365-0BA01-0AA0) 
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 Trang 8 

Ñaây laø loaïi module duøng ñeå keát noái töøng nhoùm caùc module môû roäng thaønh moät 

khoái vaø ñöôïc quaûn lyù bôûi moät module CPU. Thoâng thuôøng caùc module môû roäng 

ñöôïc gaù lieàn nhau treân moät thanh rack. Moãi thanh rack chæ coù theå gaù ñöôïc nhieàu 

nhaát 8 module môû roäng (khoâng keå module CPU vaø module nguoàn). Moät module 

CPU coù theå laøm vieäc nhieàu nhaát vôùi 4 thanh rack vaø caùc rack naøy phaûi ñöôïc noái 

vôùi nhau baèng module IM. 

4) FM (Function Module): Module coù chöùc naêng ñieàu khieån rieâng nhö: module 

ñieàu khieån ñoäng cô böôùc, module ñieàu kieån ñoäng cô servo, module PID,… 

5) CP (Communication Processor): Module truyeàn troâng giöõa PLC vôùi PLC hay 

giöõa PLC vôùi PC. 

1.2 Toå chöùc boä nhôù CPU. 

 Vuøng nhôù chöùc caùc thanh ghi: ACCU1, ACCU2, AR1, AR2,… 

 Load memory: laø vuøng nhôù chöùa chöông trình öùng duïng (do ngöôøi söû 

duïng vieát ) bao goàm taát caû caùc khoái chöông trình öùng duïng OB, FC, FB, caùc 

khoái chöông trình trong thö vieän heä thoáng ñöôïc söû duïng (SFC, SFB) vaø caùc khoái 

döõ lieäu DB. Vuøng nhôù naøy ñöôïc taïo bôûi moät phaàn boä nhôù RAM cuûa CPU vaø 

EEPROM (neáu coù EEPROM). Khi thöïc hieän ñoäng taùc xoaù boä nhôù (MRES) toaøn 

boä caùc khoái chöông trình vaø khoái döõ lieäu naèm trong RAM seõ bò xoaù. Cuõng nhö 

vaäy, khi chöông trình hay khoái döõ lieäu ñöôïc ñoå (down load) töø thieát bò laäp trình 

(PG, maùy tính) vaøo module CPU, chuùng seõ ñöôïc ghi leân phaàn RAM cuûa vuøng 

nhôù Load memory. 

 Work memory: laø vuøng nhôù chöùa caùc khoái DB ñang ñöôïc môû, khoái 

chöông trình (OB, FC, FB, SFC, hoaëc SFB) ñang ñöôïc CPU thöïc hieän vaø phaàn 

boä nhôù caáp phaùt cho nhöõng tham soá hình thöùc ñeå caùc khoái chöông trình naøy trao 

ñoåi tham trò vôùi heä ñieàu haønh vaø vôùi caùc khoái chöông trình khaùc (local block). 

Taïi moät thôøi ñieåm nhaát ñònh vuøng Work memory chæ chöùa moät khoái chöông 

trình. Sau khi khoái chöông trình ñoù ñöôïc thöïc hieän xong thì heä ñieàu haønh seõ xoaù 

khoûi Work memory vaø naïp vaøo ñoù khoái chöông trình keá tieáp ñeán löôït ñöôïc thöïc 

hieän. 

 System memory: laø vuøng nhôù chöùa caùc boä ñeäm vaøo/ra soá (Q, I), caùc bieán 

côø (M), thanh ghi C-Word, PV, T-bit cuûa timer, thanh ghi C-Word, PV, C-bit 

cuûa Couter. Vieäc truy caäp, söûa loãi döõ lieäu nhöõng oâ nhôù naøy ñöôïc phaân chia 

hoaëc bôûi heä ñieàu haønh cuûa CPU hoaëc do chöông trình öùng duïng. 

 Coù theå thaáy raèng trong caùc vuøng nhôù ñöôïc trình baøy ôû treân khoâng coù vuøng 

nhôù naøo ñöôïc duøng laøm boä ñeäm cho caùc coång vaøo/ra töông töï. Noùi caùch khaùc 
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caùc coång vaøo/ra töông töï khoâng coù boä ñeäm vaø nhö vaäy moãi leänh truy nhaäp 

module töông töï (ñoïc hoaëc göûi giaù trò) ñeàu coù taùc duïng tröïc tieáp tôùi caùc coång 

vaät lyù cuûa module. 

Baûng1.1. vuøng ñòa chæ vaø taàm ñòa chæ 

Teân goïi Kích thöôùc truy caäp Kích thöôùc toái ña (tuyø 

thuoäc vaøo CPU) 

Process input image (I) 

Boä ñeäm vaøo soá 

I 

IB 

IW 

ID 

0.0 ÷ 127.7 

0 ÷ 127 

0 ÷126 

0 ÷ 124 

 

Process output image (Q) 

Boä ñeäm ra soá 

Q 

QB 

QW 

ID 

0.0 ÷ 127.7 

0 ÷ 127 

0 ÷ 126 

0 ÷ 124 

Bit memory (M) 

Vuøng nhôù côø 

M 

MB 

MW 

MD 

0.0 ÷ 255.7 

0 ÷ 255 

0 ÷ 254 

0 ÷ 252 

Timer (T) T0 ÷ T255  

Counter (C) C0 ÷ C255  

Data block (DB) 

Khoái döõ lieäu share 

DBX 

DBB 

DBW 

DBD 

0.0 ÷ 65535.7 

0 ÷ 65535 

0 ÷ 65534 

0 ÷ 65532 

Data block (DI) DIX 0.0 ÷ 65535.7 
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Khoái döõ lieäu instance DIB 

DIW 

DID 

0 ÷ 65535 

0 ÷ 65534 

0 ÷ 65532 

Local block (L) 

Mieàn nhôù ñòa phöông 

cho caùc tham soá hình 

thöùc 

L 

LB 

LW 

LD 

0.0 ÷ 65535.7 

0 ÷ 65535 

0 ÷ 65534 

0 ÷ 65532 

Peripheral input (PI) PIB 

PIW 

PID 

0 ÷ 65535 

0 ÷ 65534 

0 ÷ 65532 

Peripheral output (PQ) PQB 

PQW 

PQD 

0 ÷ 65535 

0 ÷ 65534 

0 ÷ 65532 

 Tröø phaàn boä nhôù EEPROM thuoäc vuøng Load memory vaø moät phaàn RAM 

töï nuoâi ñaëc bieät (non-volatile) duøng ñeå löu giöõ tham soá caáu hình traïm PLC nhö 

ñòa chæ traïm (MPI address), teân caùc module môû roäng, taát caû caùc phaàn boä nhôù 

coøn laïi ôû cheá ñoä maëc ñònh khoâng coù khaû naêng töï nhôù (non-retentive). Khi maát 

nguoàn nuoâi hoaëc khi thöïc hieän coâng vieäc xoaù boä nhôù (MRES), toaøn boä noäi dung 

cuûa phaàn boä nhôù non-retentive seõ bò maát. 

1.3 Voøng queùt chöông trình cuûa PLC. 

 PLC thöïc hieän chöông trình theo chu trình laëp. Moãi voøng laëp ñöôïc goïi laø 

voøng queùt (scan). Moãi voøng queùt ñöôïc baét ñaàu baèng giai ñoaïn chuyeån döõ lieäu 

töø caùc coång vaøo soá tôùi vuøng boä ñeäm aûo I, tieáp theo laø giai thöïc hieän chöông 

trình. Trong töøng voøng queùt, chöông trình ñöôïc thöïc hieän töø leänh ñaàu tieân ñeán 

leänh keát thuùc cuûa khoái OB1 (Block end). Sau giai ñoaïn thöïc hieän chöông trình 

laø giai ñoaïn chuyeån caùc noäi dung cuûa boä ñeäm aûo Q tôùi caùc coång ra soá. Voøng 

queùt ñöôïc keát thuùc baèng giai ñoaïn truyeàn thoâng noäi boä vaø kieåm tra loãi. 

  Thôøi gian caàn thieát ñeå PLC thöïc hieän ñöôïc moät voøng queùt goïi laø thôøi gian 

voøng queùt (Scan time). Thôøi gian voøng queùt khoâng coá ñònh, töùc laø khoâng phaûi 

voøng queùt naøo cuõng ñöôïc thöïc hieän laâu, coù voøng queùt ñöôïc thöïc hieän nhanh tuyø 
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thuoäc vaøo soá leänh trong chöông trình ñöôïc thöïc hieän, vaøo khoái döõ lieäu ñöôïc 

truyeàn thoâng… trong voøng queùt ñoù. 

  

 

 

 

 

 

 

  

Nhö vaäy giöõa vieäc ñoïc döõ lieäu töø ñoái töôïng ñeå xöû lyù, tính toaùn vaø vieäc göûi tín 

hieäu ñieàu khieån tôùi ñoái töôïng coù moät khoaûng thôøi gian treã ñuùng baèng thôøi gian 

voøng queùt. Noùi caùch khaùc, thôøi gian voøng queùt quyeát ñònh tính thôøi gian thöïc 

cuûa chöông trình ñieàu khieån trong PLC. Thôøi gian voøng queùt caøng ngaén, tính 

thôøi gian thöïc cuûa chöông trình caøng cao. 

  Neáu söû duïng caùc khoái chöông trình ñaëc bieät coù cheá ñoä ngaét, ví duï nhö khoái 

OB40, OB80,… Chöông trình cuûa caùc khoái ñoù seõ ñöôïc thöïc hieän trong voøng queùt 

khi xuaát hieän tín hieäu baùo ngaét cuøng chuûng loaïi. Caùc khoái chöông trình naøy coù 

theå ñöôïc thöïc hieän taïi moïi ñieåm trong voøng queùt chöù khoâng bò goø eùp laø phaûi ôû 

trong giai ñoaïn thöïc hieän chöông trình. Chaúng haïn neáu moät tín hieäu baùo ngaét 

xuaát hieän khi PLC ñang ôû giai ñoaïn truyeàn thoâng vaø kieåm tra noäi boä, PLC seõ 

taïm döøng coâng vieäc truyeàn thoâng, kieåm tra, ñeå thöïc hieän khoái chöông trình 

töông öùng vôùi khoái tín hieäu baùo ngaét ñoù. Vôùi hình thöùc xöû lyù tín hieäu ngaét nhö 

vaäy, thôøi gian voøng queùt seõ caøng lôùn khi caøng coù nhieàu tín hieäu ngaét xuaát hieän 

trong voøng queùt. Do ñoù, ñeå naâng cao tính thôøi gian thöïc cho chöông trình ñieàu 

khieån tuyeät ñoái khoâng neân vieát chöông trình xöû lyù ngaét quaù daøi hoaëc quaù laïm 

duïng vieäc söû duïng cheá ñoä ngaét trong chöông trình ñieàu khieån. 

  Taïi thôøi ñieåm thöïc hieän leänh vaøo/ra, thoâng thöôøng leänh khoâng laøm vieäc 

tröïc tieáp vôùi coång vaøo/ra maø chæ thoâng qua boä ñeåm aûo cuûa coång trong vuøng nhôù 

tham soá. Vieäc truyeàn thoâng giöõa boä ñeäm aûo vôùi ngoaïi vi trong caùc giai ñoaïn 1 

vaø 3 do heä ñieàu haønh CPU quaûn lyù. ÔÛ moät soá module CPU, khi gaëp leänh vaøo/ra 

ngay laäp töùc, heä thoáng seõ cho döøng moïi coâng vieäc khaùc, ngay caû chöông trình 

xöû lyù ngaét, ñeå thöïc hieän leänh tröïc tieáp vôùi coång vaøo/ra. 

Hình 1.16. Voøng queùt CPU 
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1.4. Caáu truùc chöông trình. 

 Chöông trình cho S7-300 ñöôïc löu trong boä nhôù cuûa PLC ôû vuøng daønh 

rieâng cho chöông trình. Ta coù theå ñöôïc laäp trình vôùi hai daïng caáu truùc khaùc 

nhau: 

1.4.1. Laäp trình tuyeán tính 

 Toaøn boä chöông trình ñieàu khieån naèm trong moät khoái trong boä nhôù. Loaïi 

laäp trình caáu truùc chæ thích hôïp cho nhöõng baøi toaùn töï ñoäng nhoû, khoâng phöùc 

taïp.  

 

 

 

 

 

 

 

Khoái ñöôïc choïn laø khoái OB1, laø khoái maø PLC luoân luoân queùt vaø thöïc hieän caùc 

leänh trong noù thöôøng xuyeân, töø leänh ñaàu tieân ñeán leänh cuoái cuøng vaø quay laïi 

leänh ñaàu tieân: 

1.4.2 Laäp trình caáu truùc 

 Chöông trình ñöôïc chia thaønh nhöõng phaàn nhoû vôùi töøng nhieäm vuï rieâng 

bieät vaø caùc phaàn naøy naèm trong nhöõng khoái chöông trình khaùc nhau. Loaïi laäp 

trình coù caáu truùc phuø hôïp vôùi nhöõng baøi toaùn ñieàu khieån nhieàu nhieäm vuï vaø 

phöùc taïp. Caùc khoái cô baûn : 

 Khoái OB (Organization Block): khoái toå chöùc vaø quaûn lyù chöông trình ñieàu 

khieån. Coù nhieàu loaïi khoái OB vôùi nhöõng chöùc naêng khaùc nhau. Chuùng ñöôïc 

phaân bieät vôùi nhau baèng soá nguyeân theo sau nhoùm kyù töï OB, ví duï nhö OB1, 

OB35, OB80… 

 Khoái FC (Program Block): khoái chöông trình vôùi nhöõng chöùc naêng rieâng bieät 

gioáng nhö moät chöông trình con hay moät haøm (chöông trình co coù bieán hình 

thöùc). Moät chöông trình öùng duïng coù theå coù nhieàu khoái FC vaø caùc khoái FC 

naøy ñöôïc phaân bieät vôùi nhau baèng soá nguyeân theo sau nhoùm kyù töï FC, 

chaúng haïn nhö FC1, FC2, … 

Leänh  1 

Leänh  2 

… 

 

Leänh  n 

OB1 

 

Hinh 1.17. Voøng queùt PLC  
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 Khoái FB (Function Block): laø khoái FC ñaët bieät coù khaû naêng trao ñoåi moät 

löôïng döõ lieäu lôùn vôùi caùc khoái chöông trình khaùc. Caùc döõ lieäu naøy phaûi ñöôïc 

toå chöùc thaønh khoái döõ lieäu rieâng ñöôïc goïi laø Data Block. Moät chöông trình 

öùng duïng coù theå coù nhieàu khoái FB vaø caùc khoái FB naøy ñöôïc phaân bieät vôùi 

nhau baèng soá nguyeân theo sau nhoùm kyù töï FB. Chaúng haïn nhö FB1, FB2, … 

 Khoái DB (Data Block): khoái döõ lieäu caàn thieát ñeå thöïc hieän chöông trình. Caùc 

tham soá cuûa khoái do ngöôøi söû duïng töï ñaët. Moät chöông trình öùng duïng coù theå 

coù nhieàu khoái DB vaø caùc khoái DB naøy ñöôïc phaân bieät vôùi nhau baèng soá 

nguyeân theo sau nhoùm kyù töï DB. Chaúng haïn nhö DB1, DB2, … 

Chöông trình trong caùc khoái ñöôïc lieân keát vôùi nhau baèng caùc leänh goïi khoái 

vaø chuyeån khoái. Caùc chöông trình con ñöôïc pheùp goïi loàng nhau, töùc töø moät 

chöông trình con naøy goïi moät chöông trình con khaùc vaø töø chöông trình con 

ñöôïc goïi laïi goïi moät chöông trình con thöù 3. 

 

 

 

 

 

 

 

 

1.4.3 Caùc khoái OB ñaëc bieät. 

1) OB10 (Tinme of Day Interrupt ): Chöông trình trong khoái OB10 seõ ñöôïc thöïc 

hieän khi giaù trò thôøi gian cuûa ñoàng hoà thôøi gian thöïc naèm trong moät khoaûng 

thôøi gian ñaõ ñöôïc quy ñònh.  Vieäc quy ñònh khoaûng thôøi gian hay soá laàn goïi 

OB10 ñöôïc thöïc hieän nhôø chöông trình heä thoáng SFC28 hay trong baûng 

tham soá cuûa module CPU nhôø phaàn meàm STEP 7. 

2) OB20 (Time Relay Interrupt): Chöông trình trong khoái OB20 seõ ñöôïc thöïc 

hieän sau moät khoaûng thôøi gian treã ñaët tröôùc keå töø khi goïi chöông trình heä 

thoáng SFC32 ñeå ñaët thôøi gian treã. 

3) OB35 (Cyclic Interrupt): Chöông trình trong khoái OB35 seõ ñöôïc thöïc hieän 

caùch ñeàu nhau moät khoaûng thôøi gian coá ñònh. Maëc ñònh, khoaûng thôøi gian 

naøy laø 100ms, nhöng ta coù theå thay ñoåi nhôø STEP 7. 

 

 
OB1 

Hình 1.18. Laäp trình coù caáu truùc 

 

FC7 

 FB2 
FC1 

. . . 
 

FB9 

 FC3 
FB5 

. . . 
 

 

Heä 

Ñieàu 

Haønh 

. 
. .

 
 

. 
. 

. 
 

. 
. 

. 
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4) OB40 (Hardware Interrupt): Chöông trình trong khoái OB40 seõ ñöôïc thöïc 

hieän khi xuaát hieän moät tín hieäu baùo ngaét töø ngoaïi vi ñöa vaøo CPU thoâng qua 

caùc coång onboard ñaëc bieät, hoaëc thoâng qua caùc module SM, CP, FM. 

5) OB80 (Cycle Time Fault ): Chöông trình trong khoái OB80 seõ ñöôïc thöïc hieän 

khi thôøi gian voøng queùt (scan time) vöôït quaù khoaûng thôøi gian cöïc ñaïi ñaõ qui 

ñònh hoaëc khi coù moät tín hieäu ngaét goïi moät khoái OB naøo ñoù maø khoái OB naøy 

chöa keát thuùc ôû laàn goïi tröôùc. Thôøi gian queùt maëc ñònh laø 150ms. 

6) OB81 (Power Supply Fault): Chöông trình trong khoái OB81 seõ ñöôïc thöïc 

hieän khi thaáy coù xuaát hieän loãi veà boä nguoàn nuoâi. 

7) OB82 (Diagnostic Interrupt): Chöông trình trong khoái OB82 seõ ñöôïc thöïc 

hieän coù söï coá töø caùc module môû roäng vaøo/ra. Caùc module naøy phaûi laø caùc 

module coù khaû naêng töï kieåm tra mình (diagnostic cabilities). 

8) OB87 (Communication Fault): Chöông trình trong khoái OB87 seõ ñöôïc thöïc 

hieän coù xuaát hieän loãi trong truyeàn thoâng. 

9) OB100 (Start Up Information): Chöông trình trong khoái OB100 seõ ñöôïc thöïc 

hieän moät laàn khi CPU chuyeån töø traïng thaùi STOP sang RUN. 

10) OB101 (Cold Start Up Information-chæ vôùi S7-400): Chöông trình trong khoái 

OB101 seõ ñöôïc thöïc hieän moät laàn khi coâng taét nguoàn chuyeån töø traïng thaùi 

OFF sang ON. 

11) OB121 (Synchronous Error): Chöông trình trong khoái OB121 seõ ñöôïc thöïc 

hieän khi CPU phaùt hieän thaáy loãi logic trong chöông trình ñoåi sai kieåu döõ lieäu 

hay loãi truy nhaäp khoái DB, FC, FB khoâng coù trong boä nhôù. 

12) OB122 (Synchronous Error): Chöông trình trong khoái OB122 seõ ñöôïc thöïc 

hieän khi coù loãi truy nhaäp module trong chöông trình. 

1.5 Ngoân ngöõ laäp trình. 

 PLC S7-300 coù ba ngoân ngöõ laäp trình cô baûn sau: 

 Ngoân ngöõ laäp trình lieät keâ leänh STL (Statement List). Ñaây laø daïng 

ngoân ngöõ laäp trình thoâng thöôøng cuûa maùy tính. Moät chöông trình ñöôïc 

hoaøn chænh bôûi söï gheùp noái cuûa nhieàu caâu leänh theo moät thuaät toaùn nhaát 

ñònh, moãi leänh chieám moät haøng vaø coù caáu truùc chung “teân leänh” + “toaùn 

haïng”. 
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 Ngoân ngöõ laäp trình LAD (Ladder Logic). Ñaây laø daïng ngoân ngöõ ñoà 

hoaï, thích hôïp vôùi nhöõng ngöôøi laäp trình quen vôùi vieäc thieát keá maïch ñieàu 

khieån logic. 

 Ngoân ngöõ laäp trình FBD (Function Block Diagram). Ñaây cuõng laø daïng 

ngoân ngöõ ñoà hoaï, thích hôïp cho nhöõng ngöôøi quen thieát keá maïch ñieàu 

khieån soá. 

 Ngoân ngöõ laäp trình Graph. Ñaây cuõng laø daïng ngoân ngöõ ñoà hoaï, thích 

hôïp cho nhöõng heä thoáng tuaàn töï. 

 Ngoân ngöõ laäp trình SCL. Ñaây cuõng laø daïng ngoân ngöõ caáp cao, thích 

hôïp cho nhöõng ngöôøi bieát vieát ngoân ngöõ caáp cao. 

 Trong PLC coù nhieàu ngoân ngöõ laäp trình nhaèm phuïc vuï cho caùc ñoái töôïng 

söû duïng khaùc nhau. Tuy nhieân moät chöông trình vieát treân ngoân ngöõ LAD hay 

FBD coù theå chuyeån sang daïng STL, nhöng ngöôïc laïi thì khoâng. Vaø trong STL 

coù nhieàu leänh maø LAD hoaëc FBD khoâng coù. Ñaây cuõng laø theá maïnh cuûa ngoân 

ngöõ STL: 

 

 

  

 

 

 

Ví duï: 

 

Ladder Diagram LAD    Stamentl list  STL Function Block  

 Diagram   FBD 

 
 

 

 

 

Hình 1.19. STL laø ngoân ngöõ maïnh nhaát 

STL 

LAD 
FBD 

Truong DH SPKT TP. HCM http://www.hcmute.edu.vn

Thu vien DH SPKT TP. HCM - http://www.thuvienspkt.edu.vn

Ban quyen © Truong DH Su pham Ky thuat TP. HCM

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


 Trang 16 

CHÖÔNG 2:  NGOÂN NGÖÕ LAÄP TRÌNH STL 

 

2.1. Caáu truùc leänh 

 

Nhö ñaõ bieát, caáu truùc cuûa moät leänh STL coù daïng  

 

“Teân leänh” + “Toaùn haïng”  

 

Ví duï: 

Nhaõn : L   PIW274    // Ñoïc noäi dung coång vaøo cuûa module Analog 

 

 

             teân leänh   toaùn haïng 

       

   Trong ñoù toaùn haïnhg coù theå laø moät döõ lieäu hoaëc moät ñòa chæ oâ nhôù. 

 

 2.1.1 Toaùn haïng laø döõ lieäu 

 

- Döõ lieäu logic TRUE (1) vaø (0) coù ñoä daøi 1 bit.  

Ví duï  

 CALL FC1 

  In_Bit_1 = TRUE //Giaù trò logic 1 ñöôïc gaùn cho bieán hình thöùc In_Bit_1 

  In_Bit_2 = FALSE // Giaù trò logic  ñöôïc gaùn cho bieán hình thöùc  

                                                 In_Bit_2 

  Ret_val = MW0 //Giaù trò traû veà. 

 

-    Döõ lieäu soá nhò phaân.  

Ví duï 

 L 2#110011 //Naïp soá nhò phaân 110011 vaøo thanh ghi ACCU1 

-    Döõ lieäu laø soá Hexadecimal x coù ñoä daøi 1 byte (B#16#x), 1 töø (W#16#x) 

hoaëc 1 töø keùp (DW#16#x).  

Ví duï 

L    B#16#1E       //Naïp soá 1E vaøo byte thaáp cuûa thanh ghi ACCU1 

L    W#16#3A    //Naïp soá 3A2 vaøo 2 byte thaáp cuûa thanh ghi ACCU1 

L     DW#16#D3A2E //Naïp soá D3A2E vaøo thanh ghi ACCU1 

 

-  Döõ lieäu laø soá nguyeân x vôùi ñoä daøi 2 bytes  cho bieán kieåu INT.  
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Ví duï 

   L 930 

    L -1025 

 

- Döõ lieäu laø soá nguyeân x vôùi doä daøi 4 bytes daïng L#x cho bieán kieåu 

DINT.  

Ví duï 

    L L#930 

    L  L#-2047 

 

- Döõ lieäu laø soá thöïc x cho bieán kieåu REAL.  

Ví duï 

    L 1.234567e+13 

    L  930.0  

- Döõ lieäu thôøi gian cho bieán kieåu S5T daïng giôø _phuùt_giaây_mili giaây. 

Ví duï 

    L S5T#2h_1m_0s_5ms 

- Döõ lieäu thôøi gian cho bieán kieåu TOD daïng giôø:phuùt:giaây.  

Ví duï 

    L TOD#5:45:00  

- DATE: Bieåu dieãn giaù trò thôøi gian tính theo naêm/thaùng/ngaøy.  

Ví duï 

    L  DATE#1999 – 12 – 8. 

- C: Bieåu dieãn giaù trò soá ñeám ñaët tröôùc cho boä ñeám. 

 Ví duï 

                    L C#20 

- P: Döõ lieäu bieåu dieãn ñòa chæ cuûa moät bit oâ nhôù.  

Ví duï 

                 L P#Q0.0 

- Döõ lieäu “kí töï”.  

Ví duï 

L ‘ABCD’ 

L ‘E’ 
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2.1.2 Toaùn haïng laø ñòa chæ. 

Ñòa chæ oâ nhôù trong S7_300 goàm hai phaàn: phaàn chöõ vaø phaàn soá. Ví duï: 

  PIW   304  hoaëc   M            300.4  

 

 

          phaàn chöõ phaàn soá      phaàn chöõ    phaàn soá 

 

a. Phaàn chöõ chæ vò trí vaø kích thöôùc cuûa oâ nhôù.  

Chuùng coù theå laø: 

- M: Chæ oâ nhôù trong mieàn caùc bieán côø coù kích thöôùc laø 1 bit. 

- MB: Chæ oâ nhôù trong mieàn caùc bieán côø coù kích thöôùc laø 1 byte(8 bits). 

- MW: Chæ oâ nhôù trong mieàn caùc bieán côø coù kích thöôùc laø 2 bytes (16 

bits). 

- MD: Chæ oâ nhôù trong mieàn caùc bieán côø coù kích thöôùc laø 4 bytes(32 

bits). 

- I: Chæ oâ nhoâ coù kích thöôùc 1 bit trong mieàn boä ñeäm coång vaøo soá. 

- IB: Chæ oâ nhôù coù kích thöôùc laø moät byte trong mieàn boä ñeäm coång vaøo 

soá. 

- IW: Chæ oâ nhôù coù kích thöôùc laø moät töø trong mieàn boä ñeäm coång vaøo soá. 

- ID: Chæ oâ nhôù coù kích thöôùc laø hai töø trong mieàn boä ñeäm coång vaøo soá. 

- Q: Chæ oâ nhôù coù kích thöôùc 1 bit trong mieàn boä ñeäm coång ra soá. 

- QB: Chæ oâ nhôù coù kích thöôùc laø moät byte trong mieàn boä ñeäm coång rasoá. 

- QW: Chæ oâ nhôù coù kích thöôùc laø moät töø trong mieàn boä ñeäm coång ra soá. 

- QD: Chæ oâ nhôù coù kích thöôùc laø hai töø trong mieàn boä ñeäm coång ra soá. 

- PIB: Chæ oâ nhôù coù kích thöôùc 1byte thuoäc vuøng peripheral input. 

Thöôøng laø ñòa chæ coång vaøo cuûa caùc module töông töï (I/O external 

input). 

- PIW: Chæ oâ nhôù coù kích thöôùc 1 töø (2byte) thuoäc vuøng peripheral input. 

Thöôøng laø ñòa chæ coång vaøo cuûa caùc module töông töï (I/O external 

input). 

- PID: Chæ oâ nhôù coù kích thöôùc 2 töø (4bytes) thuoäc vuøng peripheral input. 

Thöôøng laø ñòa chæ coång vaøo cuûa caùc module töông töï (I/O external 

input). 

- PQB: Chæ oâ nhôù coù kích thöôùc 1 byte thuoäc vuøng peripheral output. 

Thöôøng laø ñòa chæ coång ra cuûa caùc module töông töï (I/O external input). 

- PQW: Chæ oâ nhôù coù kích thöôùc 1 töø (2bytes) thuoäc vuøng peripheral 

output. Thöôøng laø ñòa chæ coång ra/vaøo cuûa caùc module töông töï (I/O 

external input). 
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- PQD: Chæ oâ nhôù coù kích thöôùc 2 töø (4bytes) thuoäc vuøng peripheral 

output. Thöôøng laø ñòa chæ coång ra vaøo cuûa caùc module töông töï (I/O 

external input). 

- DBX: Chæ oâ nhôù coù kích thöôùc 1 bit trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN DB( open data block) 

- DBB: Chæ oâ nhôù coù kích thöôùc 1 byte trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN DB( open data block) 

- DBW: Chæ oâ nhôù coù kích thöôùc 1 töø trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN DB( open data block) 

- DBD: Chæ oâ nhôù coù kích thöôùc 2 töø trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN DB( open data block) 

- DBx.DBX: Chæ tröïc tieáp oâ nhôù coù kích thöôùc 1 bit trong khoái döõ lieäu 

DBx, vôùi x laø chæ soá cuûa khoái DB.Ví duï:DB5.DBX 1.6 

- DBx.DBB: Chæ tröïc tieáp oâ nhôù coù kích thöôùc 1 byte trong khoái döõ lieäu 

DBx, vôùi x laø chæ soá cuûa khoái DB.Ví duï:DB5.DBB 1. 

- DBx.DBW: Chæ tröïc tieáp oâ nhôù coù kích thöôùc 1 töø trong khoái döõ lieäu 

DBx, vôùi x laø chæ soá cuûa khoái DB.Ví duï:DB5.DBW 1. 

- DBx.DBD: Chæ tröïc tieáp oâ nhôù coù kích thöôùc 2 töø trong khoái döõ lieäu 

DBx, vôùi x laø chæ soá cuûa khoái DB.Ví duï:DB5.DBD 1. 

- DIX: Chæ oâ nhôù coù kích thöôùc 1 bit trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN  DI(Open distance data block) 

- DIB:Chæ oâ nhôù coù kích thöôùc 1 byte trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN  DI(Open distance data block) 

- DBW:Chæ oâ nhôù coù kích thöôùc 1 töø trong khoái döõ lieäu DB ñöôïc môû 

baèng leänh  OPN  DI(Open distance data block) 

- DBD:Chæ oâ nhôù coù kích thöôùc 2 töø trong khoái döõ lieäu DB ñöôïc môû baèng 

leänh  OPN  DI(Open distance data block) 

- L: Chæ oâ nhôù coù kích thöôùc 1 bit trong mieàn döõ lieäu ñòa phöông (local 

block) cuûa caùc khoái chöông trình OB,FC,FB. 

- LB: Chæ oâ nhôù coù kích thöôùc 1 byte trong mieàn döõ lieäu ñòa phöông 

(local block) cuûa caùc khoái chöông trình OB,FC,FB. 

- LW: Chæ oâ nhôù coù kích thöôùc 1 töø  trong mieàn döõ lieäu ñòa phöông (local 

block) cuûa caùc khoái chöông trình OB,FC,FB. 

- LD: Chæ oâ nhôù coù kích thöôùc 2 töø  trong mieàn döõ lieäu ñòa phöông (local 

block) cuûa caùc khoái chöông trình OB,FC,FB. 
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b. Phaàn soá chæ ñòa chæ cuûa byte hoaëc cuûa bit trong mieàn nhôù ñaõ xaùc ñònh. 

- Neáu oâ nhôù ñaõ ñöôïc xaùc ñònh thoâng qua phaàn chöõ laø coù kích thöôùc 1 bit 

thì phaàn soá seõ goàm ñòa chæ cuûa byte vaø soá thöù töï cuûa bit trong byte ñoù 

ñöôïc taùch vôùi nhau baèng daáu chaám. Ví duï: 

  I 1.3  // Chæ bit thöù 3 trong byte 1 cuûa mieàn nhôù boä ñeäm coång vaøo  

                                   soá  

  M 101.5 // Chæ bit thöù 5 trong byte 101 cuûa mieàn caùc bieán côø M. 

   Q 4.5 // Chæ bit thöù 5  

- Trong  tröôøng hôïp oâ nhôù ñaõ ñöôïc xaùc ñònh laø byte, töø hoaëc töø keùp thì 

phaàn soá seõ laø ñòa chæ byte ñaàu tieân trong maûng byte cuaû oâ nhôù ñoù.  

Ví duï 

    DIB 15 // Chæ oâ nhôù coù kích thöôùc 1 byte (byte 15) trong khoái DB ñaõ          

    ñöôïc môû baèng leänh OPN DI 

      DBW    18 // Chæ oâ nhôù coù kích thöôc 1 töø goàm 2 bytes 18 vaø 19  

     trong khoái DB ñaõ ñöôïc môû baèng leänh  OPN  DB 

   DB2.DBW  15     // Chæ oâ nhôù coù kích thöôùc 2 bytes 15 vaø 16  

                          trong khoái döõ lieäu DB2. 

  MD   105 // Chæ oâ nhôù coù kích thöôùc 2 töø goàm  

    4 bytes 105, 106, 107, 108 trong mieàn nhôù caùc bieán côø M. 

 

 2.1.3 Thanh ghi traïng thaùi 

Khi thöïc hieân leänh, CPU seõ ghi nhaän laïi traïng thaùi cuûa pheùp tính trung 

gian cuõng nhö cuûa keát quaû vaøo moät thanh ghi ñaëc bieät  16 bits, ñöôïc goïi laø 

thanh ghi traïng thaùi ( Status Word). Maëc duø thanh ghi traïng thaùi naøy coù ñoä daøi 

16 bits nhöng chæ söû duïng 9 bits vôùi caáu truùc nhö sau: 

              8        7          6        5       4       3        2          1         0 

BR CC1 CC0 OV OS OR STA RLO FC 

  

 FC (First check): Khi phaûi thöïc hieän moät daõy caùc leänh logic lieân tieáp nhau 

goàm caùc pheùp tính ,  vaø nghòch ñaûo, bit FC coù giaù trò baèng 1. Noùi caùch 

khaùc, FC  =0 khi daõy leänh logic tieáp ñieåm vöøa ñöôïc keát thuùc.  

Ví duï: 

A I0.2 //FC = 1 

 AN I0.3 //FC = 1 

 = Q4.0 //FC = 0 

 RLO (Result of logic operation): Keát quaû töùc thôøi cuûa pheùp tính logic vöøa 

ñöôïc thöïc hieän. Ví duï leänh 

 A I0.3 
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- Neáu tröôùc khi thöïc hieän bit FC = 0 thì coù taùc duïng chuyeån noäi dung cuûa 

coång vaøo soá I 0.3 vaøo bit traïng thaùi RLO. 

- Neáu tröùôc khi thöïc hieän bit FC = 1 thì coù taùc duïng thöïc hieän pheùp tính   

giöõa RLO vaø giaù trò logic coång vaøo I 0.3. Keát quaû cuûa pheùp tính ñöôïc ghi laïi 

vaøo bit traïng thaùi RLO. 

 STA (Status bit) : Bit traïng thaùi naøy luoân coù giaù trò logic cuûa tieáp ñieåm ñöôïc 

 chæ ñònh trong leänh. Ví duï caû hai leänh: 

 A    I 0.3 

 AN   I0.3 

     ñeàu gaùn cho bit  STA cuøng moät giaù trò laø noäi dung cuûa coång vaøo soá I 0.3. 

 OR: Ghi laïi giaù trò cuûa pheùp tính logic   cuoái cuøng ñöôïc thöïc hieän ñeå phuï 

giuùp cho vieäc thöïc hieän pheùp toaùn   sau ñoù. Ñieàu naøy laø caàn thieát vì trong 

moät bieåu thöùc haøm hai trò, pheùp tính   bao giôø cuõng phaûi ñöôïc thöïc hieän 

tröôùc caùc pheùp tính  . 

 OS (Store overflow bit): Ghi laïi giaù trò bit bò traøn ra ngoaøi maûng oâ nhôù. 

 OV (Overflow bit): Bit baùo keát quaû pheùp tính bò traøn ra ngoaùi maûng oâ nhôù. 

 CC0 vaø CC1(Condition code): Hai bit baùo traïng thaùi cuûa keát quaû pheùp tính vôi 

soá nguyeân, soá thöïc, pheùp dòch chuyeån hoaëc pheùp tính logic trong ACCU  

 BR(Binary result bit): Bit traïng thaùi cho pheùp lieân keát hai loaïi ngoân ngöõ laäp 

trình STL. Chaúng haïn cho pheùp ngöôøi söû duïng coù theå vieát moät khoái chöông 

trình FB hoaëc FC treân ngoân ngöõ STL nhöng goïi vaø söû duïng chuùng trong moät 

chöông trình khaùc vieát treân LAD. Ñeå taïo ra ñöôïc moái lieân keát ñoù, ta caàn phaûi 

keát thuùc chöông trình trong FB, FC baèng leänh ghi: 

- 1 vaøo BR, neáu chöông trình chaïy khoâng coù loãi . 

- 0 vaøo BR, neáu chöông trình chaïy coù loãi. 

 Khi söû duïng caùc khoái haøm ñaëc bieät cuûa heä thoáng (SFC hoaëc SFB), traïng thaùi 

laøm vieäc cuûa chöông trình cuõng ñöôïc thoâng baùo ra ngoaøi qua bit traïng thaùi 

BR nhö sau 

- 1 neáu SFC hay SFB thöïc hieän khoâng coù loãi. 

- 0 neáu coù loãi khi thöïc hieän SFC hay SFB. 

Chuù yù: Moät chöông trình vieát treân STL (tuyø thuoäc vaøo töøng ngöôøi laäp trình) coù 

theå bao goàm nhieàu Network. Moãi moät Network chöùa moät coâng ñoaïn cuï theå. ÔÛ 

moãi ñaàu Network, thanh ghi traïng thaùi nhaän giaù trò 0, chæ sau leänh ñaàu tieân 

cuûa Network, caùc bit traïng thaùi môùi thay ñoåi  theo keát quaû pheùp tính. 

 Network 1 

 Ñoaïn chöông trình 1      

 Network 2 

                    Ñoaïn chöông trình 2 
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 Network 3        

                    Ñoaïn chöông trình 3 
 

 

2.2  CAÙC LEÄNH CÔ BAÛN 

 

2.2.1 Nhoùm leänh logic  

Bao goàm caùc leänh sau 


 A         And 

 AN      And Not 

 O         Or 

 ON      Or Not 

 X         ExOr 

 XN      ExOr Not 

 

a. Leänh gaùn 

 

Cuù phaùp = <toaùn haïng> 

Toaùn haïng laø ñòa chæ I, Q, M, L, D. 

 

Leänh gaùn giaù trò logic cuûa RLO tôùi oâ nhôù coù ñòa chæ ñöôïc chæ thò trong toaùn 

haïng. Leänh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau (Kí hieäu – 

chæ noäi dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

 

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    0       x   -  1 

Ví duï: Thöïc hieän Q4.0 = I0.3 

Network 1 

 A             I0.3  //Ñoïc noäi dung cuûa I0.3 vaøo RLO 

 =  Q4.0 //Ñöa keát quaû ra coång Q4.0 

 

b. Leänh thöïc hieän pheùp tính AND 

 

Cuù phaùp A <toaùn haïng> 

 

Toaùn haïng laø döõ lieäu kieåu BOOL hoaëc ñòa chæ I, Q, M, L, D, T, C. 
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Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa toaùn haïng vaøo RLO. Ngöôïc laïi khi FC 

= 1 noù seõ thöïc hieän pheùp tính AND giöõa RLO vôùi toaùn haïng vaø ghi laïi keát quaû 

vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    x       x   x  1 

 

Ví duï1: Thöïc hieän Q4.0 = I0.3 AND I0.4 (maéc noái tieáp hai coâng taéc) 

Network 1 

A   I0.3  // Ñoïc noäi dung cuûa I0.3 vaøo RLO 

A I0.4  //Keát hôïp AND vôùi noäi dung coång I0.4 

=   Q4.0   //Ñöa keát quaû ra coång Q4.0 

Ví duï 2: 

 

 

 

 

 

 

 

 

 

c. Leänh thöïc hieän pheùp tính AND vôùi giaù trò nghòch ñaûo 

 

Cuù phaùp AN <toaùn haïng> 

 

Toaùn haïng laø döõ lieäu kieåu BOOL hoaëc ñòa chæ I, Q, M, L, D, T, C. 

Neáu FC = 0 leänh seõ gaùn giaù trò logic nghòch ñaûo cuûa toaùn haïng vaøo RLO. 

Ngöôïc laïi khi FC = 1 noù seõ thöïc hieän pheùp tính AND giöõa RLO vôùi giaù trò 

nghòch ñaûo cuûa toaùn haïng vaø ghi laïi keát quaû vaøo RLO. 

 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    x       x   x  1 
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Ví duï1: Thöïc hieän Q4.0 = I0.3 AND NOT (I0.4) (maéc noái tieáp hai coâng taéc) 

Network 1 

A I0..3  // Ñoïc noäi dung cuûa I0.3 vaøo RLO 

AN         I0.4            //Keát hôïp AND  vôùi ñaûo noäi dung coång I0.4 

=  Q4.0   //Ñöa keát quaû ra coång Q4.0 
 

Ví duï 2 

 

 

 

 

 

 

 

 

d. Leänh OR 

 

Cuù phaùp           O  <Toaùn haïng > 

 

Toaùn haïng laø döõ lieäu kieåu BOOL hoaëc ñòa chæ I, Q, M, L, D, T, C. 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa toaùn haïng vaøo RLO. Ngöôïc laïi khi FC 

= 1 noù seõ thöïc hieän pheùp tính OR giöõa RLO vôùi toaùn haïng vaø ghi laïi keát quaû 

vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    x       x   x  1 

Ví duï 
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e. Leänh OR NOT 

Cuù phaùp           ON  <Toaùn haïng > 

 

Toaùn haïng laø döõ lieäu kieåu BOOL hoaëc ñòa chæ I, Q, M, L, D, T, C. 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa toaùn haïng vaøo RLO. Ngöôïc laïi khi FC 

= 1 noù seõ thöïc hieän pheùp tính OR giöõa RLO vôùi NOT toaùn haïng vaø ghi laïi keát 

quaû vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

Ví duï 

 

 

 

 

 

 

 

 

f. Leänh thöïc hieän pheùp tính AND vôùi moät bieåu thöùc 

 

Cuù phaùp           A( 

 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa bieåu thöùc trong daáu ngoaëc sau noù vaøo 

RLO. Ngöôïc laïi khi FC = 1 noù seõ thöïc hieän pheùp tính AND giöõa RLO vôùi giaù trò 

logic cuûa bieåu trong daáu ngoaëc sau noù vaø ghi laïi keát quaû vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

 

 

 

Ví du Q0.4 = (( I0.0 OR M10.0) AND (I0.2 OR M10.3)) AND (M10.1) 
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g. Leänh thöïc hieän pheùp tính AND vôùi giaù trò nghòch ñaûo cuûa moät bieåu thöùc 

  

Cuù phaùp                         AN( 

 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa bieåu thöùc trong daáu ngoaëc sau noù vaøo 

RLO. Ngöôïc laïi khi FC = 1 noù seõ thöïc hieän pheùp tính AND giöõa RLO vôùi giaù trò 

nghòch ñaûo logic cuûa bieåu trong daáu ngoaëc sau noù vaø ghi laïi keát quaû vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

 

 

 

h. Leänh thöïc hieän pheùp tính OR vôùi gia 1trò moät bieåu thöùc 

 

Cuù phaùp                             O( 

 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa bieåu thöùc trong daáu ngoaëc sau noù vaøo 

RLO. Ngöôïc laïi khi FC = 1 noù seõ thöïc hieän pheùp tính OR giöõa RLO vôùi giaù trò 

logic cuûa bieåu trong daáu ngoaëc sau noù vaø ghi laïi keát quaû vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 

 

 

 

    

i. Leänh thöïc hieän pheùp tính OR vôùi nghòch ñaûo giaù trò moät bieåu thöùc 

Cuù phaùp                         ON( 

 

Neáu FC = 0 leänh seõ gaùn giaù trò logic cuûa bieåu thöùc trong daáu ngoaëc sau noù vaøo 

RLO. Ngöôïc laïi khi FC = 1 noù seõ thöïc hieän pheùp tính OR giöõa RLO vôùi giaù trò 

nghòch ñaûo logic cuûa bieåu trong daáu ngoaëc sau noù vaø ghi laïi keát quaû vaøo RLO. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi ( Status word) nhö sau (kí hieäu – chæ noäi 

dung bit khoâng bò thay ñoåi, x laø bò thay ñoåi theo leänh): 
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j. Leänh ghi giaù trò logic 1 vaøo RLO 

 

Cuù phaùp  SET 

 

Leänh khoâng coù toaùn haïng vaø coù taùc duïng ghi 1 vaøo RLO 

Leâïnh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau: 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    -       1   1  0 

 

k. Leänh gaùn coù ñieàu kieän giaù trò logic 1 vaøo oâ nhôù 

Cuù phaùp S <toaùn haïng> 

Toaùn haïng laø ñòa chæ bit I, Q, M, L, D. 

Neáu RLO = 1, leänh seõ ghi giaù trò 1 vaøo oâ nhôù coù ñòa chæ cho trong toaùn haïng. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau:  

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    0       x   -  0 

 

l. Leänh gaùn coù ñieàu kieän giaù trò logic 0 vaøo oâ nhôù 

 

Cuù phaùp R <toaùn haïng> 

 

Toaùn haïng laø ñòa chæ bit I, Q, M, L, D. 

Neáu RLO = 1, leänh seõ ghi giaù trò 0 vaøo oâ nhôù coù ñòa chæ cho trong toaùn haïng. 

Leänh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau:  

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    0       x   -  0 

 

m.  Leänh phaùt hieän söôøn leân 

 

Cuù phaùp  FP <toaùn haïng> 

 

Toaùn haïng laø ñòa chæ bit I, Q, M, L, D vaø ñöôïc söû duïng nhö moät bieán côø ñeå ghi 

nhaän laïi giaù trò cuûa RLO taïi vò trí naøy trong chöông trình, nhöng cuûa voøng queùt 

tröôùc. Taïi moãi voøng leänh seõ kieåm tra: neáu bieán côø (toaùn haïng) coù giaù trò 0 vaø 
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RLO coù giaù trò 1 thì seõ ghi 1 vaøo RLO, caùc tröôøng hôïp khaùc thì ghi 0, ñoàng thôøi 

chuyeån noäi dung cuûa RLO vaøo laïi bieán côø. Nhö vaäy RLO seõ coù giaù trò 1 trong 

moät voøng queùt  khi coù söôøn leân trong RLO. Ví duï: Leänh phaùt hieän söôøn leân. 

A  I0.0 

FP  M10.0 

=  Q4.5 

Seõ töông ñöông vôùi  

ñoaïn chöông trình sau  

 A   I0.0 

 AN M10.0 

 =  Q4.5 

 A  I0.0 

 =  M10.0 

 Leänh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau: 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    0       x   x  1 

 

n. Leänh phaùt hieän söôøn xuoáng 

 

Cuù phaùp  FN <toaùn haïng> 

 

 Toaùn haïng laø ñòa chæ bit I, Q, M, L, D vaø ñöôïc söû duïng nhö moät bieán côø ñeå 

ghi nhaän laïi giaù trò cuûa RLO taïi vò trí naøy trong chöông trình, nhöng cuûa 

voøng queùt tröôùc. Taïi moãi voøng leänh seõ kieåm tra: neáu bieán côø (toaùn haïng) 

coù giaù trò 1 vaø RLO coù giaù trò 0 thì seõ ghi 1 vaøo RLO, caùc tröôøng hôïp khaùc 

thì ghi 0, ñoàøng thôøi chuyeån noäi dung cuûa RLO vaøo laïi bieán côø. Nhö vaäy 

RLO seõ coù giaù trò 1 trong moät voøng queùt  khi coù söôøn xuoáng trong 

RLO.Leänh taùc ñoäng vaøo thanh ghi traïng thaùi (Status word) nhö sau: 

  

BR CC1 CC0 OV OS OR STA RLO FC 

   -   -    -    -    -    0       x   x  1 

 

2.2.2  Leänh ñoïc, ghi trong ACCU 

 

Caùc CPU cuûa S7_300 thöôøng coù hai thanh ghi Accunulator (ACCU) kí hieäu laø 

ACCU1 vaø ACCU2. Hai thanh ghi ACCU coù cuøng kích thöôùc 32 bits    (1 töø 

keùp). Moïi pheùp tính toaùn treân soá thöïc, soá nguyeân, caùc pheùp tính logic vôùi maûng 

Giaù trò RLO taïi
voøng queùt hieän thôøi

Giaù trò RLO taïi voøng
queùt tröôùc ñöôïc nhôù

vaøo M10.0

Hình 2.1. Hình moâ taû leänh FP 
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nhieàu bits… ñeàu ñöôïc thöïc hieän treân hai thanh ghi naøy. Chuùng coù caáu truùc nhö 

sau: 

 31           24 23          16   15       8 7                 0 

ACCU1  

 

 

ACCU2  

 

 Töø cao Töø thaáp 

 

a. Leänh ñoïc vaøo ACCU 

Cuù phaùp  L <toaùn haïng> 

Toaùn haïng laø döõ lieäu (soá nguyeân, thöïc, nhò phaân) hoaëc ñòa chæ. Neáu laø ñòa chæ 

thì  

- Byte IB, QB, PIB, MB, LB, DBB, DIB trong khoaûng 0 – 65535 

- TöØ IW, QW, PIW, MW, LW, DBW, DIW trong khoaûng 0 – 65534 

- Töø keùp ID, QD, PID, MD, LD, DBD, DID trong khoaûng töø 0 – 65534 

Neáu laø döõ lieäu thì caùc daïng döõ lieäu hôïp leä cuûa toaùn haïng cho trong baûng sau 

 

Byte 

cao 

Byte 

thaáp 

Byte 

cao 

Byte thaáp 

Byte 

cao 

Byte 

thaáp 

Byte 

cao 

Byte thaáp 
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Baûng 2.1: Caùc daïng döõ lieäu hôïp leä cuûa toaùn haïng 

 

Leänh L coù taùc duïng chuyeån döõ lieäu hoaëc noäi dung cuûa oâ nhôù coù ñòa chæ laø toaùn 

haïng vaøo thanh ghi ACCU1. Noäi dung cuõ cuûa ACCU1 ñöôïc chuyeån vaøo 

ACCU2. Trong tröôøng hôïp giaù trò chuyeån vaøo coù kích thöôùc nhoû hôn töø keùp thì 

chuùng seõ ñöôïc ghi vaøo theo thöù töï byte thaáp cuûa töø thaáp, byte cao cuûa töø thaáp, 

byte thaáp cuûa töø cao, byte cao cuûa töø cao. Nhöõng bit coøn troáng trong ACCU1 

ñöôïc ghi 0.  

Ví duï1  

L    IB0 

seõ chuyeån noäi dung cuûa IB0 vaøo ACCU1 nhö sau 

 31           24 23         16 15         8 7                 0 

ACCU1  

 

Ví duï 2 

L    MW20  //seõ chuyeån noäi dung cuûa MW20 goàm 2 bytes MB20, MB21 

vaøo ACCU1 theo thöù töï 

 31           24 23         16 15          8 7                 0 

Döõ lieäu Ví duï                  Giaûi thích 

  … L           +5 Ghi 5 vaøo töø thaáp cuûa ACCU1 

B#(…,…) L            B#(1,8) Ghi 1 vaøo byte cao cuûa töø thaáp vaø 8 vaøo 

byte thaáp cuûa töø thaáp trong ACCU 

L# … L           L#5 Ghi 5 vaøo ACCU1(soá nguyeâ 32 bits) 

16# … L    B#16#2E 

L     W#A2EB 

L      DW#2C1E_A2EB 

Döõ lieäu daïng cô soá 16 

2# … L 2#11001101 Döõ lieäu daïng cô soá 2 

‘…’ L    ‘AB’ 

L    ‘ABCD’ 

Döõ lieäu daïng kí töï 

C# … L     C#1000 Döõ lieäu laø giaù trò ñaët tröôùc cho boä ñeám 

S5TIME# 

… 

L   S5TIME#2S Döõ lieäu laø giaù trò ñaët tröôùc cho Timer 

(PV) 

P# … L   P#M10.2 Döõ lieäu laø ñòa chæ oâ nhôù(duøng cho con 

troû) 

D# … L   D#2000-6-20 Döõ lieäu laø giaù trò veà 

ngaøy/thaùng/naêm(16bits) 

T# … L      T#0H_1M_10S Döõ lieäu veà thôøi gian giôø/phuùt/giaây(32bits) 

    0    0    0       IB 0 
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ACCU1  

 

 Leänh khoâng söûa ñoåi thanh ghi traïng thaùi (Status word). 

 

Ví duï 3 

 L  100  // ACCU1 =100  

 L   200  // ACCU1 =200, ACCU2=100 

 

b. Leänh chuyeån noäi dung cuûa ACCU1 tôùi oâ nhôù. 

 

Cuù phaùp T <toaùn haïng> 

 

Toaùn haïng laø ñaïi chæ: 

- Byte IB, QB, PIB, MB, LB, DBB, DIB trong khoaûng 0 – 65535 

- TöØ IW, QW, PIW, MW, LW, DBW, DIW trong khoaûng 0 – 65534 

- Töø keùp ID, QD, PID, MD, LD, DBD, DID trong khoaûng töø 0 - 65534 

 

Leänh chuyeån noäi dung cuûa ACCU1 vaøo oâ nhôù coù ñòa chæ laø toaùn haïng. Leänh 

khoâng thay ñoåi noäi dung cuûa ACCU2.Trong tröôøng hôïp oâ nhôù coù kích thöôùc nhoû 

hôn töø keùp thì noäi dung cuûa ACCU1 ñöôïc chuyeån ra theo thöù töï byte thaáp cuûa 

töø thaáp, byte cao cuûa töø thaáp, byte thaáp cuûa töø cao, byte cao cuûa töø cao.  

Ví duï  

T QB0 

seõ chæ chuyeån noäi dung cuûa byte thaáp cuûa töø thaáp trong ACCU1 vaøo IB0 vaø 

leänh  

T MW20 

seõ chæ chuyeån byte cao cuûa töø thaáp vaøo MW20, byte thaáp cuûa töøø thaáp vaøo 

MW21.  

Leänh khoâng söûa ñoåi thanh ghi traïng thaùi (Status word). 

    0    0    MB20       MB21 

Truong DH SPKT TP. HCM http://www.hcmute.edu.vn

Thu vien DH SPKT TP. HCM - http://www.thuvienspkt.edu.vn

Ban quyen © Truong DH Su pham Ky thuat TP. HCM

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


 Trang 32  

CHÖÔNG 3 

NGOÂN  NGÖÕ GRAPH VAØ ÖÙNG DUÏNG 
 

Khi laäp trình cho PLC söû duïng khoái FB thì chuùng ta coù theå söû duïng ngoân 

ngöõ Graph. Ngoân ngöõ naøy raát thuaän lôïi trong nhöõng heä thoáng ñieàu khieån tuaàn 

töï. Löu yù trong khi caøi ñaët phaàn meàm Step7 ta phaûi choïn caøi ñaët ngoân ngöõ naøy.  
 

3.1 Tạo một khối FB dưới dạng ngôn ngữ Graph 
3.1.1. Tạo một khối FB Graph 
Bước 1: Double click vào folder Blocks. 
Bước 2: Chọn trên thanh Menu: Insert > S7 Block > Function Block.  
Bước 3: Một hộp thoại “ Properties” xuất hiện. Chọn ngôn ngữ lập trình là Graph 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Rồi chọn OK. Như vậy kết quả là một khối FB1 được tạo ra trong folder 

Blocks 
 

3.1.2. Viết chương trình theo kieåu tuần tự 

Ñeå tieän theo doõi xeùt ví duï ñieàu khieån khôûi ñoäng SAO/TAMGIAC cuûa ñoäng 

cô 3 pha nhö sau 
 
Động cơ không đồng bộ 3 pha rô to lồng sóc phải được vận hành cả 2 chiều 

quay. Để khắc phục được dòng khởi động lớn, động cơ phải được khởi động với 
chế độ kết nối sao - tam giác  

Hình 3.1. Choïn ngoân ngöõ Graph khi laäp trình treân khoái FB 
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YÊU CẦU 
 

Khi nhấn nút S1 thì động cơ chạy và quay cùng chiều kim đồng hồ, và động 
cơ sẽ quay theo chiều ngược lại nếu nhấn nút S2. Công tắc tơ chính K1 cho chiều 
quay cùng chiều kim đồng hồ và K2 cho chiều ngược lại, kích hoạt    công tắc tơ  
chế độ sao là K4 và một timer. Sau một khoảng thời gian khởi động gần 5 s, động 
cơ tự động ngắt chế độ chạy sao. Công tác tơ chính K1 vẫn còn được kích hoạt và 
ngắt sự kết nối với chế độ chạy sao – công tắc tơ K4 trước khi chuyển sang kết nối 
với chế độ tam giác – công tắc tơ K3. Chiều quay của động cơ chỉ được thay đổi 
khi động cơ đã được tắt trước đó. Động cơ chỉ có thể được tắt khi nhấn nút S0, 
độc lập với trạng thái hoạt động . Trạng thái ON của động cơ phải được  hiển thị 
qua đèn H1 và H2 tuỳ thuộc chiều quay của động cơ. Khi động cơ quá tải nó sẽ 
được tự động tắt qua rơ le Q1(S5). 

Hoaït ñoäng Sao/tamgiac cuûa ñoäng cô 3 pha ñöôïc trình baøy theo löu ñoà 

giaûi thuaät sau 

  
 
 
 
 
   

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

START 

 

S1=1 

S2=1 

 

ĐC QUAY CÙNG 
CHIỀU KIM ĐỒNG 
HỒ (K1) Ở CHẾ ĐỘ 

SAO (K4)  

ĐC QUAY NGƯỢC 
CHIỀU KIM ĐỒNG HỒ 

(K2) Ở CHẾ ĐỘ SAO 
(K3) 

S0=1 
 

SAU 
10S 

SAU 
10S 

ĐC QUAY CÙNG 
CHIỀU KIM ĐỒNG 
HỒ (K1) Ở CHẾ ĐỘ 

TAM GIÁC (K3)  

N 

N 
N 

N 

Y 

Y 

Y 

 

Y 

Y 

ĐC QUAY CÙNG 
CHIỀU KIM ĐỒNG 
HỒ (K1) Ở CHẾ ĐỘ 

TAM GIÁC (K3)  

Hình 3.2. Löu ñoàng giaûi thuaät cuûa khôûi ñoäng Sao/tamgiac 
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Baûng ñòc chæ vaøo ra 

 

Ngoõ vaøo Ngoõ ra 
THIẾT BỊ 
NGOÀI 

ĐỊA CHỈ THIẾT BỊ NGOÀI ĐỊA CHỈ 

S0 I0.0 Q1 Q01 
S1 I0.1 Q2 Q0.2 
S2 I0.2 Q3 Q0.3 
S5 I0.5 Q4 Q0.4 

Trình töï laäp trình nhö sau 

 
Sau khi bắt đầu làm việc với S7 Graph bằng cách double click vào khối 

FB1 thì hệ thống được chèn vào một STEP đầu tiên và một TRANSITION đầu 
tiên.  

Có 2 phương pháp để tạo cấu trúc Sequencer.  
Phương pháp 1: Ở chế độ “Direct”: Insert > Direct 
Phương pháp 2: Ở chế độ “Drap-and-Drop”: Insert > Drap-and-Drop 
Sau đây chỉ trình bày cách viết theo phương pháp 1 

 Bước 1: Chọn transition 1 và nhấp chuột vào biểu tượng một lần 
 
 
 

 
Kết quả tạo ra một step 2. Tại step này động cơ thực hiện chế độ quay cùng 

chiều kim đồng hồ, và mạch được kết nối dạng SAO. 
 Bước 2: Chọn step 2 và chọn biểu tượng 

 
 
 

Điều này sẽ mở ra một nhánh xen vào cho chế độ động cơ cũng quay cùng 
chiều kim đồng hồ nhưng mạch được kết nối dạng TAM GIÁC. Nhánh này bắt 
đầu với transition 3 (T3) 

 Bước 3: Tiếp tục với con chuột đang ở tại vị trí T3, nhấp chuột chọn biểu 
tượng  

  
 
 

Và sẽ được chèn vào step 3 cùng với transition 4 
 

 Bước 4: Chọn step 1 và chọn biểu tượng 
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Điều này sẽ mở ra một nhánh xen vào cho chế độ động cơ ngược chiều kim đồng 
hồ. Nhánh này bắt đầu với transition 5 (T5) 
 

 Bước 5: Tương tự như nhánh chính ứng với chế độ quay của động cơ là 
cùng chiều kim đồng hồ.Vẫn để con chuột tại transition 5 và nhấp chuột vào biểu 
tượng sau một lần 

 
 
 

 
Kết quả tạo ra một step 4 và transition 6. Tại step này động cơ thực hiện 

chế độ quay ngược chiều kim đồng hồ, và mạch được kết nối dạng SAO. 
tiếp tục thực hiện giống như nhánh chinh ta được mạch như sau: 
 

 Bước 6: Và bấy giờ ta hoàn thành cấu trúc của một Sequencer bằng cách 
đầu tiên ta chọn transition 1 (T1) rồi nhấp chuột chọn biểu tượng  
 

 
 
và rồi chọn step1 hoặc gõ vào số “1” 
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Hình 3.2. Taïo nhaùnh trong Graph 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.2. Viết chương trình các ACTION cho các step 
 
Cũng có 2 phương pháp để viiết chương trình các action  cho các step và các 
transition: Direct và Drap-and-Drop  
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Sau đây sẽ sử dụng phương pháp Drap-and-Drop : Insert > Drap-and-Drop 
Bước 1: Chọn trên thanh menu Insert > Action 
Kết quả là: Trên con chuột sẽ xuất hiện biểu tượng sau 

 
 
 
 

Bước 2: chèn dòng action rỗng bằng cách nhấp chuột vào ô action 
Bước 3: Enter vào các action 

Một action bao gồm 1 lệnh và  1 địa chỉ. Trong ngoân ngöõ Graph coù 4 lệnh hay söû 

duïng : 
S Set ngõ ra 
R Reset ngõ ra 

D Delay 1 khoaûng thôøi gian (xem theâm S4 hình 3) 

C         Ñeám söï kieän 

 

S1 CU C20 

S1 CR C20 

 
 
3.3. Viết chương trình các TRANSITION 
 

Có các hàm logic “ Coâng tắc thường mở”, “Công tắc thường đóng”, “ Hàm 
so sánh” được sử dụng cho các điều kiện-CONDITION trong các transition. Viết 
chương trình cho các transition như sau: 
Bước 1: Chọn View >LAD 
 

 Chèn vào công tắc thường mở 
 

 Chèn vào công tắc thường đóng 
 

 Chèn vào phép so sánh 
 
Bước 2: Sau khi nhấp chọn và chèn vào đúng vị trí có thể thoát ra bất cứ lúc nào 
bằng cách nhấn phím ESC 
 
Bước 3: Enter địa chỉ vào. Nhấp chuột vào vùng yêu cầu                
     Rồi gõ vào đó địa chỉ hoặc kí hiệu của địa chỉ ( Ví dụ I0.0 hoặc   
I0.0_Nut_nhan_dung ) 
Bước 4:  

Söû duïng Counter C20 ñeám soá haønh ñoäng cuûa S1 

Reset Counter C20  
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Khi S4 chaïy 

ñöôïc 20 S thì 

M0.1 ñaûo traïng 

thaùi 
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3.4. Lưu và đóng chöông trình lại 
 

Khi lưu chöông trình lại, thì phaàn meàm tự động được kiểm tra (compile) 
Bước 1: Chọn trên thanh menu File > Save 
Kết quả là: một hộp thoại “Select Instance DB” được mở ra với thông số mặc định 

là DBx (vôùi x truøng vôùi x cuûa khoái FBx ví duï neáu FB1 thì DB1) 
Bước 2: Đồng ý với mặc định này bằng cách nhấp chọn “OK” 
Kết quả là: Khối dữ liệu “DB-Data block” tự động được tạo ra trong folder 
“Blocks” 

Bước 3: Đóng chöông trình lại bằng cách chọn File > Close 

Hình 3.3. Chöông trình khôûi ñoäng sao/tamgiac duøng ngoân ngöõ Graph  

Truong DH SPKT TP. HCM http://www.hcmute.edu.vn

Thu vien DH SPKT TP. HCM - http://www.thuvienspkt.edu.vn

Ban quyen © Truong DH Su pham Ky thuat TP. HCM

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


 Trang 40  

 
3.5 Gọi chương trình từ trong khối FB1 vào khối OB1 
 

Chương trình điều khiển động cơ được gọi vào trong khối OB1. Chúng ta 
có thể tạo khối OB1 viết dưới dạng LAD, FBD, STL, hoặc SCL  ( Ở đây khối 
OB1 được tạo ra dưới dạng LAD. Chương trình của khối OB1 được biểu diễn như 
sơ đồ sau. Làm trình tự các bước như sau: 
Bước 1: Mở folder “Blocks” trong S7 program trong cửa sổ SIMATIC Manager 
Bước 2: Double- click vào khối OB1 
Bước 3: Chọn ngôn ngữ viết dạng LAD bằng cách View > LAD 
Bước 4: Mở Overviews ra  nếu chư có sẵn bằng cách View > Overwiews 
Rồi nhấp chọn FB, rồi double-click vào FB1  
Bước 5: Gõ tên của khối dữ liệu “DB1” vào phía trên  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bước 6: Lưu và đóng khối OB1 lại bằng cách File > Save rồi File >Close 
 

3.6. Download chương trình xuống CPU và kiểm tra tuaàn töï chöông trình 
 
3.6.1. Download chương trình xuống CPU 
Để cho phép download chương trình xuống CPU, ta phải download tất cả các khối 
( DB1, FB1, OB1, FC70/71, FC72 và/hoặc FC73) xuống CPU theo các bước sau: 

Hình 3.4. Goïi khoái FB trong OB1  
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Bước 1: Mở cửa sổ chính SIMATIC Manager và chọn folder “ Blocks”. 
Bước 2: Chọn menu PLC> Download 
 
3.6.2 Kiểm tra chương trình 
 

Để kiểm tra chương trình , đòi hỏi cần phải kết nối với với CPU 
Bước 1:  Mở cửa sổ chính SIMATIC Manager. 
Bước 2: Mở Sequencer bằng cách double-click vào khối FB1. 
Bước 3: Chọn menu Debug > Monitor. 

 
Kết quả là: Trạng trái chương trình được hiển thị ( Step đầu tiên được kích hoạt). 
Step nào hoạt động được hiển thị màu xanh 
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Chöông 4 

PHAÀN MEÀM STEP7  

4.1 Sô löôïc veà phaàn meàm STEP7. 

  STEP 7 laø moät phaàn meàm duøng ñeå phuïc vuï cho vieäc ñaët caáu hình vaø laäp trình 

cho caùc boä ñieàu khieån laäp trình ñöôïc (PLC_Programmable Logic Controller). Ñaây 

laø boä phaàn meàm do haõng Siemens thieát keá, bao goàm caùc version cô baûn sau : 

 STEP 7 Micro/Dos vaø STEP 7 Micro/Win daønh cho caùc öùng duïng chuaån, ñôn 

giaûn treân SIMATIC S7-200. 

 STEP 7 Mini daønh cho caùc öùng duïng chuaån, ñôn giaûn treân SIMATIC S7-300 vaø 

SIMATIC C7-620. 

 STEP 7 daønh cho caùc öùng duïng treân SIMATIC S7-300/S7-400, SIMATIC M7-

300/M7-400 vaø SIMATIC C7 vôùi caùc chöùc naêng roäng hôn: 

 Coù khaû naêng gaùn caùc thoâng soá cho caùc module haøm vaø caùc boä xöû lyù truyeàn 

thoâng. 

 Coù theå hoaït ñoäng ôû cheá ñoä nhieàu maùy tính. 

 Truyeàn thoâng döõ lieäu toaøn cuïc. 

 Truyeàn döõ lieäu theo söï kieän söû duïng caùc khoái haøm truyeàn thoâng 

(communication function blocks). 

 Ñaët caáu hình keát noái. 

4.1.1 Caøi ñaët Step7. 

 Yeâu caàu phaàn cöùng: 

 Heä ñieàu haønh : Windows 95, Windows 98 hay Windows NT. 

 Phaàn cöùng : 

 Boä xöû lyù 80486 hay cao hôn. 

 RAM: ít nhaát laø 32Mbytes. 

 Maøn hình, chuoät, baøn phím coù hoã trôï Win 95/98/NT. 

 Caøi ñaët STEP 7: 

 Cho ñóa STEP 7 vaøo oå ñóa CD-ROM. 

 Chaïy chöông trình setup treân ñóa, cuõng gioáng nhö vieäc caøi ñaët caùc phaàn 

meàm khaùc. Tuy nhieân vieäc caøi ñaët STEP 7 coù vaøi ñieåm khaùc bieät so vôùi caùc 

phaàn meàm khaùc: 
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 Khai baùo soá hieäu saûn phaåm: soá hieäu saûn phaåm luoân ñi keøm theo ñóa. 

Do ñoù khi quaù trình caøi ñaët yeâu caàu soá hieäu saûn phaåm, baïn phaûi ñieàn ñaày ñuû 

caùc thoâng tin vaøo caùc muïc yeâu caàu. 

 Ñaêng kyù baûn quyeàn (AuthorsW): baûn quyeàn cuûa STEP 7 do Simens 

cung caáp thöôøng ñöôïc chöùa trong ñóa meàm rieâng (maøu ñoû). Ta coù theå ñaêng 

kyù baûn quyeàn ngay trong quaù trình caøi ñaët hay sau khi caøi ñaët phaàn meàm 

xong baïn chaïy chöông trình AuthorsW.exe coù trong danh saùch cuûa 

SIMATIC. 

4.1.2 Caùc coâng vieäc khi laøm vieäc vôùi phaàn meàm STEP 7. 

 Laäp keá hoaïch cho boä ñieàu khieån. 

 Thieát keá caáu truùc chöông trình. 

 Khôûi ñoäng STEP 7. 

 Taïo caáu truùc project. 

 Ñaët caáu hình cho traïm. 

 Ñaët caáu hình maïng vaø caùc keát noái truyeàn thoâng. 

 Ñònh nghóa caùc kyù hieäu. 

 Taïo chöông trình. 

 Ñoái vôùi S7: taïo vaø ñaùnh giaù caùc döõ lieäu tham chieáu. 

 Ñaët caáu hình caùc thoâng ñieäp. 

 Ñaët caáu hình caùc bieán ñieáu khieån. 

 Download chöông trình xuoáng boä ñieàu khieån. 

 Kieåm tra chöông trình. 

 Quan saùt hoaït ñoäng vaø chaån ñoaùn loãi. 

4.1.3. Set giao dieän PG/PC. 

 Vôùi vieäc thieát laäp naøy, giuùp baïn thieát laäp kieåu keát noái giao tieáp giöõa thieát bò 

laäp trình (PC) vaø boä ñieàu khieån logic khaû trình (PLC).  

 Khi Set PG/PC Interfaces laàn ñaàu tieân, ta phaûi caøi ñaët module giao tieáp nhö 

sau:  
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Hình 4.1. Set giao dieän PG/PC 

 Trong hoäp thoaïi Set PG/PC Interfaces ta choïn loaïi card phuø hôïp chuaån 

giao tieáp heä thoáng maïng vaø click vaøo nuùt Properties… 

 Hoäp thoaïi Properties - PC Adapter hieän ra, ta thieát laäp caùc thoâng soá giao 

tieáp caàn thieát nhö: ñòa chæ, toác ñoä truyeàn,…  

4.2 CAÙCH TAÏO 1 CHÖÔNG TRÌNH ÖÙNG DUÏNG VÔÙI STEP7  

4.2.1. Caùc böôùc soaïn thaûo 1 Project  

Caùch xaây döïng caáu hình phaàn cöùng cho traïm PLC. 

Ví duï xaây döïng caáu hình phaàn cöùng cho 1 traïm nhö sau: 

- Phaàn cöùng cuûa  traïm goàm moät  thanh ray  

     RACK-300 :  thanh RAIL 

- Treân thanh naøy coù gaén caùc moâñun : nguoàn PS , CPU, DI/DO, AI, AO treân caùc 

SLOT Trong ñoù :  

 SLOT 1: coù gaén moâñun nguoàn “PS 307 5A vôùi maõ soá : 6ES7 307-1EA00-

0AA0 

 Choïn loaïi module 

thích hôïp. 

 Click choïn Install. 
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    SLOT 2 vaø SLOT 3  : Coù gaén moâñun CPU –300 “CPU 315-2 DP  vôùi maõ soá : 

6ES7  315- 2AFO3-OABO- V1.2 ” moâñun naøy ñeå truyeàn döõ lieäu töø  S7-300 

baèng ñöôøng truyeàn maïng MPI vaø PROFIBUS vôùi toác ñoä 1.5 MB 

   SLOT 4 : Moâñun tín hieäu ngoõ vaøo/ ra digital  DI8 /DO8 x24V/0.5A  vôùi maõ 

soá : 6ES7  323-1BH00-0AA0  

  SLOT 5 : Moâñun tín hieäu ngoõ vaøo analog AI 2x12bit vôùi maõ soá : 6ES7  331-

7KB02-0AB0 

  SLOT 6 : Moâñun tín hieäu ngoõ ra analog A0 2x12bit vôùi maõ soá : 6ES7  332-

5HB01-0AB0 

Chuù yù: ta khoâng theå ñaët caùc thaønh phaàn ôû cöûa soå beân phaûi vaøo cöûa soå beân traùi 

moät caùch tuyø tieän khoâng theo moät thöù töï. Thöôøng thì caùc thaønh phaàn ñöôïc ñaët 

vaøo caùc Slot ôû cöûa soå beân traùi theo thöù töï nhö sau: 

 Slot 1: chæ söû duïng ñaët modul nguoàn. 

 Slot 2: chæ söû duïng ñaët modul CPU. 

 Slot 3: thoâng thöôøng ñeå roãng. 

 Slot 4 tôùi Slot 11: duøng cho caùc module truyeàn thoâng xöû lyù( modul xuaát, 

modul nhaäp, modul vaøo ra töông töï…). 

 

 

 

 

 

 

 

 

 

 

   Hình 4.2. Thöù töï saép xeáp cuûa caùc Slot treân moät Rack 
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Choïn  ‘New Project’ Wizard 

4.2.2. Thieát laäp phaàn cöùng cho traïm 

1.   Khôûi ñoäng phaàn meàm SIMATIC Manager 

 Start -> SIMATIC Manager  hoaëc doub_ click vaøo bieåu töôïng :  

 

 

 

 

 

  

    Hình 4.2. Bieåu töôïng cuûa SIMATIC Manager  

2. Taïo 1 Project môùi : File ->‘New Project’ Wizard   

 

    

 

     

 

 

 

 

    Hình 4.3. Taïo 1 Project môùi   

3. Ñaët teân cho Project :  

 

 

 

    

     

 

 

 

 

 

 

 

 

 

                            Hình 4.4. Ñaët teân cho Project  

Doub_click vaøo icon 

SIMATIC Manager  

1.Ñaët teân Project 

2.Choïn OK 
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4.  Cheøn SIMATIC 300 Station :  Insert -> station ->  SIMATIC  300 Station  

 

 

    
 

                 Hình 4.5. Cheøn 1 traïm SIMATIC môùi  

 

 

5. Choïn  SIMATIC  300 Station(1) 

                            

  
    

 

     Hình 4.6: Choïn traïm SIMATIC vöøa taïo  

 

 

 

6. Môû caáu hình phaàn cöùng :  

Choïn  SIMATIC  

300 Station 

Choïn  SIMATIC 300(1) 
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Click doub vaøo Hardware  hoaëc vaøo Edit -> Open Object   

 

    
 

    Hình 4.7: Môû caáu hình phaàn cöùng  

7. Laáy thanh rail ôû slot 0 naèm döôùi daáu + cuûa RACK :  

SIMATIC 300 -> RACK-300 -> doub- click  Rail  

 

 
  Hình 4.8: Vò trí cuûa moãi Slot  

8. Click vaøo SLOT 1  

Choïn  Open Object 

 Slot 1: moâñun nguoàn  PS 

 Slot 2: moâñun CPU 300   

 Slot 4: moâñun SM-DI/DO 

 Slot 5: moâñun SM-AI  

 Slot 6: moâñun SM-A0 

Doub_click 

vaøo  Rail 
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choïn  moâñun nguoàn “PS 307 5A vôùi maõ soá : 6ES7 307-1EA00-0AA0,  baèng 

caùch doub_click vaøo PS 307 5A 

      
                   Hình 4.9. Khai baùo ñòa chæ nguoàn 

9. Töông töï nhö böôùc 8 click  vaøo Slot 2  choïn  moâñun CPU –300 “CPU 315-2 

DP  vôùi maõ soá : 6ES7  315- 2AFO3-OABO baèng caùch doub_click vaøo  V1.2  

luùc ñoù seõ xuaát hieän hoäp thoaïi “Properties” nhaäp ñòa chæ DP cuûa CPU laø 15 vaø 

nhaán phím NEW  sau ñoù choïn OK  

 

      

 

 

 

 

 

 

 

 

 

 

 

 

        Hình 4.10: Khai baùo ñòa chæ vaø maïng keát noái Profibus  

Keát quaû seõ taïo ra : heä thoáng chuû (1) “PROFIBUS(1) : DP” 

Doub_click vaøo 
PS 307 5A 

 Nhaäp ñòa chæ  

CPU 

 Choïn New 
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Hình 4.11: Khai baùo CPU 

 

10. Click vaøo slot 4 : töø  SM-300  choïn  moâñun tín hieäu ngoõ vaøo/ ra digital  

 DI8 /DO8 x24V/0.5A  vôùi maõ soá : 6ES7  323-1BH00-0AA0 baèng caùch doub _click 

vaøo DI8 /DO8 x24V/0.5A   

 

11.   Click vaøo slot 5 töø  SM-300 choïn moâñun tín hieäu ngoõ vaøo analog AI 2x12bit 

vôùi maõ soá : 6ES7  331-7KB02-0AB0 baèng caùch doub _click vaøo AI 2x12bit 

  

12. Click vaøo slot 6 töø  SM-300 choïn moâñun tín hieäu ngoõ ra analog A0 2x12bit vôùi 

maõ soá : 6ES7  332-5HB01-0AB0 baèng caùch doub _click vaøo A0 2x12bit 

 

13. Sau khi thieát laäp phaàn cöùng xong ta tieán haønh löu vaø kieåm tra baèng caùch choïn 

menu Station > Save and Compile 

 

14. Download caáu hình  phaàn cöùng xuoáng döôùi CPU cuûa PLC baèng caùch choïn menu  

PLC -> Download       

        

 

1.Choïn ‘Save and 
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Hình 4.12. Save vaø download caáu hình phaàn cöùng  

4.2.3 Soaïn thaûo chöông trình cho caùc khoái logic  

Sau khi khai baùo xong caáu hình cöùng cho moät traïm PLC vaø quay trôû veà cöûa 

soå chính cuûa step7 ta seõ thaáy Step7 trong thö muïc SIMATIC 300(1) baây giôø coù 

theâm caùc thö muïc con CPU315-2DP, S7 Program(1), Sources, Blocks   

Môû cöûa soå SIMATIC manager leân vaø choïn ‘Block’  

Môû taát caû caùc khoái logic (OB, FC, FB, DB) chöùa chöông trình öùng duïng seõ naèm 

trong thö muïc Block. Maëc ñònh saün trong thö muïc naøy ñaõ coù saün khoá OB1 

                

 
 

1. Click  ‘+’ Simatic 300(1) 
2. Click ‘+’ S7 program(1) 
3. choïn  ‘Block’  
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Hình 4.13. Choïn khoái Blocks  

Muoán soaïn thaûo chöông trình cho khoái OB1 ta doud-click vaøo bieåu töôïng OB1 

beân nöûa cöûa soå beân phaûi 

 
 

Hình 4.14: Laäp trình treân khoái OB1 

Ñeå khai baùo vaø soaïn thaûo chöông trình cho caùc khoái OB khaùc hoaëc cho caùc khoái FC 

, FB hay DB, ta coù theå taïo moät khoái môùi ngay tröïc tieáp töø chöông trình soaïn thaûo 

baèng caùch cheøn theâm khoái môùi ñoù tröôùc töø cöûa soå chính cuûa step7 baèng phím   

 Double –click  

vaøo  khoái OB 
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Insert -> S7 Block -> choïn kieåu khoái -> choïn soá khoái -> nhaán OK   

 

 
 

 

Hình 4.15. Cheøn theâm khoái  ñieàu khieån  

 

 

Choïn kieåu khoái  
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CHÖÔNG 5   

 

BOÄ HIEÄU CHÆNH PID, CAÙC HAØM XÖÛ LYÙ TÍN HIEÄU TÖÔNG TÖÏ VAØ 

ÖÙNG DUÏNG 

  

5.1 Giôùi thieäu. 

Nhieàu naêm tröôùc ñaây boä ñieàu khieån PID ñöôïc coi laø boä ñieàu khieån lyù 

töôûng ñoái vôùi caùc ñoái töôïng coù moâ hình lieân tuïc. Boä PID thöïc söï laø boä ñieàu 

khieån ñoäng maø vieäc thay ñoåi caùc tham soá cuûa boä ñieàu khieån coù khaû naêng laøm 

thay ñoåi ñaëc tính ñoäng vaø tónh cuûa heä thoáng ñieàu khieån töï ñoäng. 

Boä ñieàu khieån PID thöïc chaát laø thieát bò ñieàu khieån thöïc hieän luaät ñieàu 

khieån  ñöôïc moâ taû baèng phöông trình sau: 

u.(t) = kpe(t) +   D

t

I

Tde
T

 
0

1
e.(t) 

trong ñoù e(t) laø tín hieäu vaøo, u(t) laø tín hieäu ra cuûa boä ñieàu khieån, kp laø heä soá 

khueách ñaïi cuûa luaät ñieàu khieån tyû leä , TI haèng soá thôøi gian tích phaân vaø TD laø 

haèng soá thôøi gian vi phaân .  

 

 

 

 

         

 

Hình 5.1. Ñieàu khieån vôùi boä ñieàu khieån PID 

 

Vôùi boä ñieàu khieån PID, ngöôøi söû duïng deã daøng tích hôïp caùc luaät ñieàu 

khieån khaùc nhö  luaät ñieàu khieån tæ leä (luaät P), ñieàu khieån tæ leä - tích phaân (luaät 

PI),  ñieàu khieån tæ leä -vi phaân (luaät PD). Boä ñieàu khieån PID luoân laø moät phaàn 

töû khoâng theå thay theá ñöôïc trong caùc quaù trình töï ñoäng khoáng cheá nhieät ñoä, 

möùc, toác ñoä…  

Moät trong nhöõng öùng duïng cuûa boä ñieàu khieån PID trong ñieàu khieån 

thích nghi vaø ñieàu khieån môø laø thöôøng xuyeân phaûi chænh ñònh laïi caùc tham soá 

cuûa noù cho phuø hôïp vôùi söï thay ñoåi khoâng bieát tröôùc cuûa ñoái töôïng cuõng nhö 

cuûa moâi tröôøng nhaèm ñaûm baûo ñöôïc caùc chæ tieâu chaát löôïng ñaõ ñeà ra trong heä 

thoáng. Neáu nhö ta ñaõ töï ñoäng hoaù ñöôïc coâng vieäc thay ñoåi tham soá naøy thì boä 

ñieàu khieån PID ñoù seõ laø moät boä ñieàu khieån beàn vöõng vôùi moïi taùc ñoäng cuûa 

nhieãu noäi cuõng nhö nhieãu ngoaïi leân heä thoáng. 

Boä hieäu 

chænh PID 

Ñoái töôïng 

ñieàu 

khieån 

Ngoõ ra Ngoõ vaøo 
- 

e(t) u(t) 
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Cuõng chính vì vaäy maø caùc thieát bò ñieàu khieån quaù trình nhö DCS 

Disbuted Control system, PLC Programmeble Logic Control,PCS Process 

Control System cuûa caùc haõng saûn xuaát thieát bò töï ñoäng treân theá giôùi khoâng 

theå thieáu ñöôïc module ñieàu khieån PID hoaëc cöùng hoaëc meàm. 

Ñeå söû duïng toát caùc module naøy, ngöôøi thieát keá phaûi naém ñöôïc caùc 

phöông phaùp choïn luaät ñieàu khieån vaø caùc tham soá cho boä ñieàu khieån. 

 

Trong phaàn meàm Step 7 coù nhieàu khoái FB ñeå hoå trôï vieäc vieát chöông trình ñieàu 

khieån thieát bò söû duïng luaät hieäu chænh PID, nhö FB40,FB41, FB58, FB59.. 

5.2 Moâñun meàm FB58 

5.2.1 Giôùi thieäu  

Sô ñoà khoái FB58 
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Hình 5.2. Sô ñoà khoái cuûa khoái FB58 

Hình 5.3. Caùc caâu leänh cuûa FB58 

Ñieåm Setpoint 

Ñieåm Setpoint ñaët ôû ngoõ vaøo SP- INT ôû daïng soá thöïc nhö moät ñaïi löôïng vaät lí 

hoaëc tæ leä phaàn traêm. Ñieåm setpoint vaø giaù trò xöû lí thöôøng taïo thaønh sai soá 

phaûi coù cuøng moät ñôn vò 

Söï löïa choïn giaù trò xöû lí (PVPER_ON)  

Tuyø thuoäc vaøo PVER ON, giaù trò coù theå coù ñöôïc töø thieát bò ngoaïi vi hoaëc ôû 

daïng soá thöïc  

PVER-ON xöû lí giaù trò ngoõ vaøo:  

- TRUE: Giaù trò xöû lí ñöôïc ño thoâng qua thieát bò ngoaïi vi Analog (PIWxxx) 

taïi ngoõ 

     vaøo PV PER.                                      

- FALSE: Giaù tri xöû lí coù ñöôïc ôû daïng soá thöïc ñaët taïi ngoõ vaøo PV-IN.  

Söï chuyeån ñoåi giaù trò xöû lí baèng haøm CRP-IN (PER-MOD) 

Haøm CRP_IN chuyeån giaù trò ngoaïi vi sang daïng soá thöïc tuyø thuoäc vaøo söï löïa 

choïn PER_MODE 
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Vieäc tieâu chuaån hoaù giaù trò xöû lí PV_NORM (PF_FAC, PV_OFFS) 

Haøm PV_NORM tính toaùn giaù trò ngoõ ra  cuûa haøm CRP_IN nhö sau: 

"Output of PV_NORM" = "Output of CPR_IN" * PV_FAC + PV_OFFS 

Noù ñöôïc duøng vôùi yù ñònh: 

PV_FAC:nhö heä soá cuûa giaù trò xöû lí. 

PV_OFFS:söï offset cuûa giaù trò xöû lí. 

Söï tieâu chuaån hoaù nhieät ñoä sang tæ leä phaàn traêm: ñieåm setpoint ôû daïng %, ta 

phaûi chuyeån giaù trò nhieät ñoä ñöôïc ño sang tæ leä %. 

Söï tieâu chuaån hoaù tæ leä % sang nhieät ñoä: ñieåm setpoint ôû daïng nhieät ñoä ta 

phaûi chuyeån ñieän aùp/doøng ñieän. 

Vieäc tính toaùn caùc thoâng soá: 

- PV_FAC = range of PV_NORM/range of CRP_IN; 

- PV_OFFS = LL(PV_NORM) - PV_FAC * LL(CRP_IN);  

 Vôùi: 

      range:  daûi,vuøng,mieàn 

LL    :     giôùi haïn döôùi 

Vôùi giaù trò maëc ñònh (PV_FAC = 1.0 vaø PV_OFFS = 0.0) thì söï tieâu chuaån 

hoaù seõ khoâng ñöôïc thích hôïp thì keát quaû giaù trò xöû lí laø ngoõ ra taïi PV. 

Ví duï vieäc tieâu chuaån hoaù giaù trò xöû lí 

Neáu ñaët giaù trò setpoint laø tæ leä % vaø baïn coù mieàn nhieät ñoä laø (-20 ÷+85)oC thì 

baïn phaûi tieâu chuaån hoaù daûi nhieät ñoä thaønh tæ leä %. 

Sô ñoà döôùi ñaây trình baøy moät ví duï veà vieäc chuyeån mieàn nhieät ñoä (-

20÷+85)oC sang tæ leä töø 0 ÷100% 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Hình 5.4. Ví duï vieäc tieâu chuaån hoaù giaù trò xöû lí 
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Hình thöùc sai soá 

Söï khaùc bieät giöõa ñieåm setpoint vaø giaù trò xöû lí tröôùc khi bò ñöa vaøo mieàn 

cheát seõ taïo ra sai soá. Ñieåm setpoint vaø giaù trò xöû lí phaûi coù cuøng kieåu ñôn 

vò(% hoaëc ñaïi löôïng vaät lí) 

Mieàn cheát (Deadb_W) 

Vôùi moãi moät giaù trò, Deaband seõ ñöa ra moät khoaûng sai soá 

Neáu  DEADB_W = 0 thì Deaband seõ bò giaûm söï kích hoaët. Sai soá ñöôïc ñaëc 

tröng baèng thoâng soá ER 

  

  

 

 

 

 

 

 

 

Hình 5.5. Minh hoaï veà mieàn cheát 

 

Thuaät toaùn PID (GAIN, TI, TD, D_F) 

 

Sô ñoà döôùi ñaây laø sô ñoà khoái cuûa thuaät toaùn PID 
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       Hình 5.6. Sô ñoà khoái cuûa thaät toaùn PID 

 

Thuaät toaùn PID hoaït ñoäng nhö moät thuaät toaùn veà söï ñònh vò. Caùc cô caáu tæ 

leä,tích phaân,vi phaân(DIF) ñöôïc keát noái song song vaø  coù theå ñöôïc kích hoaït 

hoaëc khoâng kích hoaït moät caùch rieâng leû. Ñieàu naøy cho pheùp boä P, boä PI, boä 

PID ñöôïc caáu hình. 

Söï ñieàu chænh cuûa ngöôøi ñieàu khieån seõ hoã trôï boä PI,PID. Boä ñieàu khieån 

nghòch ñöôïc thi haønh khi söû duïng moät boä GAIN (cooling controller). 

Neáu set giaù trò TI,TD ñeán giaù trò 0.0 thì baïn seõ thu ñöôïc moät boä ñieàu khieån P 

taïi ñieåm hoaït ñoäng 

 
Töøng böôùc ñaùp öùng trong mieàn thôøi gian laø: 

LMN_Sum(t):laø bieán toång trong cheá ñoä töï ñoäng cuûa boä ñieàu khieån 

ER (0)           : laø söï thay ñoåi töøng böôùc cuûa sai soá ñaõ ñöôïc chuaån hoaù 

GAIN    : ñoä lôïi cuûa boä ñieàu khieån 

    TI    : thôøi gian tích phaân 

    TD                 :thôøi gian vi phaân 

D_                 :heä soá vi phaân 

 

 

        

 

 

 

 

 

 

 

 

 

    Hình 5.7. Minh hoaï caùc thoâng soá cuûa thuaät toaùn PID 

            

    Boä tích phaân (TI, I_ITL_ON, I_ITLVAL) 

Trong ñieàu khieån tay noù ñöôïc ñieàu chænh nhö sau: 

 LMN_I = LMN - LMN_P - DISV. 

Neáu bieán vaän haønh (manipulated variable) bò giôùi haïn thì cô caáu I seõ bò ngöng 

hoaït ñoäng. Neáu sai soá ñöa cô caáu I trôû veà trong khoaûng cho pheùp cuûa bieán  
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vaän haønh thì cô caáu I coù theå ñöôïc thay ñoåi baèng caùch: cô caáu I cuûa boä ñieàu 

khieån coù theå ñöôïc kích hoaët bôûi TI = 0. 

 Söï hoaët ñoäng cuûa cô  caáu P seõ bò yeáu ñi khi  coù söï thay ñoåi cuûa ñieåm setpoint. 

Söï hoaït ñoäng cuûa cô  caáu P seõ bò yeáu ñi khi  coù söï thay ñoåi cuûa ñieåm 

setpoint (PFAC_SP) 

Ñeå ngaên chaën söï quaù taàm(vöôït quaù giôùi haïn),baïn coù theå laøm giaûm söï hoaët 

ñoäng  cuûa cô caáu P baèng caùch söû duïng heä soá tæ leä ñoái vôùi söï thay ñoåi cuûa 

ñieåm setpoint, thoâng soá PFAC_SP. Söû duïng PFAC_SP, baïn coù theå choïn caùc 

giaù trò lieân tieáp töø 0.0 ÷1.0 ñeå quyeát  ñònh hieäu quaû cuûa cô caáu P khi ñieåm 

setpoint thay ñoåi. 

- PFAC_SP=1.0: cô caáu P bò aûnh höôûng neáu ñieåm setpoint bò thay ñoåi. 

- PFAC_SP=0.0: cô caáu P hoaøn toaøn khoâng bò thay ñoåi neáu ñieåm setpoint bò 

thay 

      ñoåi. 

Vieäc giaûm aûnh höôûng cuûa cô caáu P seõ ñaït ñöôïc baèng söï caân baèng theâm 

 cô caáu I 

Caùc nhaân toá cuûa cô caáu vi phaân (TD, D_F) 

Cô caáu D cuûa boä ñieàu khieån seõ bò giaûm kích hoaët vôùi TD = 0. 

Neáu cô caáu D ñöôïc kích hoaët ,theo moái quan heä giöõa caùc thoâng soá ta coù: 

TD = 0.5 * CYCLE * D_F 

Caøi ñaët thoâng soá cuûa boä ñieàu khieån P vaø PD vôùi ñieåm ñang hoaët ñoäng 

Trong giao dieän cuûa ngöôøi söû duïng, cô caáu I khoâng ñöôïc kích hoaët (TI = 0.0) 

vaø cô caáu (TD = 0.0) cuõng vaäy. Sau ñoù caøi ñaët caùc thoâng soá: 

I_ITL_ON = TRUE 

I_ITLVAL = ñieåm ñang hoaët ñoäng. 

Ñieàu khieån hoài tieáp (DISV) 

Bieán hoài tieáp coù theå ñöôïc theâm vaøo trong ngoõ vaøo DISV 

Vieäc tính toaùn bieán vaän haønh 

Sô ñoà khoái döôùi ñaây laø sô ñoà veà söï tính toaùn bieán vaän haønh 
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Hình 5.8. Sô ñoà khoái tính toaùn bieán vaän haønh  

Vuøng ñieàu khieån (CONZ_ON, CON_ZONE) 

Neáu  CONZ_ON = TRUE, boä ñieàu khieån seõ hoaït ñoäng trong vuøng ñieàu 

khieån. Ñieàu naøy coù nghóa laø boä ñieàu khieån hoaït ñoäng theo thuaät toaùn sau: 

- Neáu PV vöôït quaù giaù trò SP_INT gaàn caän treân cuûa CON_ZONE, thì giaù trò  

LMN_LLM laø giaù trò ngoõ ra nhö bieán vaän haønh (ñieàu khieån theo chu trình 

kín) 

- Neáu PV naèm döôùi giaù trò SP_INT gaàn caän döôùi cuûa CON_ZONE,thì giaù trò 

LMN_HLM laø giaù trò ngoõ ra nhö bieán vaän haønh(ñieàu khieån theo chu trình 

kín) 

- Neáu PV naèm trong khoaûng vuøng ñieàu khieån (CON_ZONE) bieán vaän haønh 

seõ giöõ giaù trò cuûa noù laïi töø LMN_Sum cuûa thuaät toaùn. 

Chuù yù: Söï chuyeån ñoåi töø ñieàu khieån kín sang ñieàu khieån töï ñoäng theo chu 

trình kín thì söï ñieàu khieån seõ tính toaùn 1 khoaûng treã khoaûng 20% cuûa vuøng 

ñieàu khieån. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 5.9. Sô ñoà vuøng ñieàu khieån (CONZ_ON, CON_ZONE)  

 

Tröôùc khi kích hoaït vuøng ñieàu khieån tay, phaûi chaéc chaén raèng vuøng ñieàu 

khieån khoâng quaù heïp, neáu vuøng ñieàu khieån quaù nhoû, söï dao ñoäng seõ xuaát 

hieän trong bieán vaän haønh vaø bieán xöû lí. 

Thuaän lôïi cuûa vuøng ñieàu khieån 
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Khi giaù trò xöû lí thuoäc vuøng ñieàu khieån , cô caáu D taïo ra moät söï giaûm cöïc 

nhanh cuûa bieán vaän haønh. Ñieàu naøy coù nghóa laø vuøng ñieàu khieån chæ höõu ích 

khi cô caáu D  ñöôïc kích hoaït. Khoâng coù vuøng ñieàu khieån, veà cô baûn cô caáu P 

seõ laøm giaûm bieán vaän haønh. Vuøng ñieàu khieån seõ coù taùc ñoäng tôùi söï oån ñònh 

nhanh hôn maø khoâng coù söï vöôït quaù giôùi haïn hoaëc sai leäch döôùi( thaáp hôn trò 

soá danh nghóa). 

Xöû lí giaù trò baèng tay (MAN_ON, MAN) 

Baïn coù theå baät coâng taéc ñieàu khieån tay hoaëc töï ñoäng . Trong ñieàu khieån tay 

bieán vaän haønh ñöôïc ñieàu chænh ñeán moät giaù trò theo höôùng daãn . 

Cô caáu tích phaân (INT) ñöôïc set ñeán giaù trò LMN - LMN_P – DISV vaø cô caáu 

vi phaân (DIF) ñöôc set ñeán giaù tri 0 vaø ñöôïc ñoàng boä hoaù beân trong. Do ñoù 

chuyeån sang cheá ñoä töï ñoäng seõ ít bò va chaïm hôn. 

Chuù yù: trong khi ñieàu khieån thoâng soá MAN_ON khoâng coù aûnh höôûng gì. 

Söï giôùi haïn cuûa bieán vaän haønh LMNLIMIT (LMN_HLM, LMN_LLM) 

Giaù trò cuûa bieán vaän haønh ñöôïc giôùi haïn ñeán 2 giaù trò giôùi haïn LMN_HLM vaø 

LMN_LLM bôûi haøm LMNLIMIT. Neáu söï giôùi haïn naøy ñaït ñöôïc, ñieàu naøy 

ñöôïc chæ ñònh bôûi bit thoâng tin QLMN_HLM vaø QLMN_LLM. Neáu bieán vaän 

haønh bò giôùi haïn thì cô caáu seõ bò ngöng hoaët ñoäng. Neáu sai soá ñöa cô caáu I veà 

ñuùng vuøng bieán vaän haønh thì cô caáu I seõ ñöôïc phuïc hoài.  

Tay ñoåi söï giôùi haïn cuûa bieán keát quaû  

Neáu mieàn bieán vaän haønh bò giaûm vaø giaù trò môùi khoâng ñöôïc giôùi haïn cuûa bieán 

vaän haønh naèm ngoaøi khoaûng giôùi haïn, thì  cô caáu I vaø giaù trò cuûa bieán vaän 

haønh seõ bò thay ñoåi. 

Vieäc tieâu chuaån hoaù bieán vaän haønh (LMN_FAC, LMN_OFFS) 

Haøm LMN_NORM chuaån hoaù bieán vaän haønh theo coâng thöùc sau: 

LMN = LmnN * LMN_FAC + LMN_OFFS 

Noù ñöôïc duøng vôùi yù ñònh: 

 LMN_FAC:  nhö heä soá cuûa giaù trò xöû lí. 

 LMN_OFFS: söï offset cuûa giaù trò xöû lí. 

Giaù trò bieán vaän haønh cuõng coù khaû naêng ñöôïc ñònh daïng töø beân ngoaøi. 

Haøm CRP_OUT chuyeån soá thöïc sang giaù trò ngoaïi vi theo coâng thöùc sau: 

LMN_PER = LMN * 27648/100 

Vôùi giaù trò maëc ñònh (LMN_FAC = 1.0 vaø LMN_OFFS = 0.0) thì söï chuaån 

hoaù seõ khoâng ñöôïc thích hôïp. Luùc naøy keát quaû cuûa bieán vaän haønh laø ngoõ ra 

 taïi LMN. 

Ghi nhaän vaø chuyeån taûi caùc thoâng soá cuûa boä ñieàu khieån 

- Vieäc ghi nhaän caùc thoâng soá cuûa boä ñieàu khieån SAVE_PAR 
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Neáu vieäc caøi ñaët caùc thoâng soá hieän haønh ñöôïc duøng, baïn coù theå ghi nhaän 

chuùng vaøo moät caáu truùc ñaëc bieät trong haøm FB 58"TCONT_CP" tröôùc khi taïo 

ra moät söï thay ñoåi .Neáu baïn ñieàu chænh boä ñieàu khieån, vieäc caùc thoâng soá ghi 

nhaän ñöôïc vieát ñeø leân thay  giaù trò tröôùc khi chuyeån ñoåi. 

PFAC_SP, GAIN, TI, TD, D_F, CONZ_ON vaø CONZONE ñöôïc chuyeån sang 

caáu truùc PAR_SAVE. 

- Vieäc taûi caùc  thoâng soá ñaõ ñöôïc ghi nhaän cuûa boä ñieàu khieån UNDO_PAR 

Haøm naøy ñöôïc söû duïng ñeå kích hoaët thoâng soá ñöôïc caøi ñaët cuoái cuøng cuûa boä 

ñieàu khieån maø baïn ñaõ ghi nhaän ñeå phuïc hoài boä ñieàu khieån (chæ trong ñieàu 

khieån tay) 

  

 

 

 

 

 

 

Hình 5.10. Sô ñoà khoái cuûa vieäc ghi nhaän vaø chuyeån taûi caùc thoâng soá cuûa boä 

ñieàu khieån 

 

Vieäc chuyeån ñoåi caùc thoâng soá giöõa boä PI vaø PID LOAD_PID (PID_ON) 

Theo quaù trình ñieàu chænh caùc thoâng soá PID vaø PI seõ ñöôïc löu vaøo trong caáu 

truùc PI_CON vaø PID_CON. Tuyø vaøo PID_ON,baïn coù theå söû duïng 

LOAD_PID trong ñieàu khieån tay ñoái vôùi caùc thoâng soá PI  hoaëc PID ñeå taïo ra 

caùc thoâng soá cuûa boä ñieàu khieån 

 
Chu yù: 

Caùc thoâng soá cuûa boä ñieàu khieån chæ ñöôïc ghi trôû laïi vaøo boä ñieàu khieån vôùi 

UNDO_PAR hoaëc LOAD_PID khi ñoä lôïi cuûa boä ñieàu khieån khaùc 0. 

LOAD_PID copy caùc thoâng soá neáu ñoä lôïi GAIN <> 0 (caùc thoâng soá cuûa moät 

trong hai boä PI vaø PID )  

D_F, PFAC_SP coù theå ñöôïc set ñeán giaù trò  maëc ñònh baèng caùch ñieàu chænh. 

Nhöõng giaù trò naøy sau ñoù coù theå ñöôïc xaùc ñònh bôûi ngöôøi ñieàu chænh. 

LOAD_PID khoâng thay ñoåi caùc thoâng soá naøy. 

Vôùi LOAD_PID vuøng ñieàu khieån luoân ñöôïc tính toaùn laïi. 
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(CON_ZONE = 250/GAIN) ngay khi CONZ_ON = FALSE ñöôïc set. 

Quaù trình chaïy (Tuning) cuûa FB 58 "TCONT_CP" 
 Giôùi thieäu 

 Vôùi vieäc ñieàu khieån vieäc chaïy töï ñieàu chænh cuûa "TCONT_CP", boä ñieàu 

khieån PI/PID caäp nhaät töï ñoäng caùc thoâng soá cuûa boä ñieàu khieån. Coù hai 

phöông thöùc chaïy Tuning: 

- Chaïy töï ñieàu chænh baèng söï tieán gaàn tôùi ñieåm hoaït ñoäng vôùi söï thay ñoåi 

töøng böôùc cuûa ñieåm ñaët. 

-  Chaïy töï ñieàu chænh ñieåm hoaït ñoäng baèng vieäc ñaët moät bit baét ñaàu. 

Caû hai caùch treân, quaù trình xöû lí ñöôïc kích thích bôûi coù theå löïa choïn 

bieán gaùn thay ñoåi. Sau khi chæ ra ñieåm uoán, caùc thoâng soá boä ñieàu khieån 

coù giaù trò vaø boä ñieàu khieån ñöôïc khôûi hoaït ñoäng töï ñoäng vaø tieáp tuïc 

ñieàu khieån vôùi nhöõng thoâng soá naøy. 

Baïn coù theå ñieàu khieån vieäc chaïy ñieàu chænh baèng vieäc söû duïng caùc 

thoâng soá ñöôïc thieát laäp treân giao dieän chöông trình thieát keá. 

Caùc böôùc tieán haønh: 

-   Start -> Simatic Manager ->  Project -> Block -> DB58 -> Option -> 

Curve Recorder         

 

 

 

 

 

 

 

 

Hình 5.11.  Maøn hình caäp nhaät ñoà thò  

 

- Thieát laäp caùc thoâng soá vaøo sau khi vaøo Curve Recorder nhaáp vaøo 

Setting  

  ( caøi ñaët thoâng soá ) 
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Hình 5.12. Maøn hình caøi ñaët thoâng soá 

- Sau khi caøi ñaët thoâng soá xong ta vaøo Data Block -> Open Oline -> 

Option         Controller Tuning  

 Keát quaû 

Caùc thoâng soá ñieàu khieån ñöôïc caäp nhaät trong quaù trình FB58 

"TCONT_CP" chaïy töï ñieàu chænh.  

Nhaân toá ñeå laøm giaûm thoâng soá taùc ñoäng P laø PFAC_SP = 0.8 

-  Ñoä lôïi cuûa boä ñieàu khieån  GAIN 

-  Thôøi gian boä tích phaân: TI 

- Thôøi gian boä vi phaân: TD 

- Nhaân toá boä vi phaân: D_F = 5.0 

-  Vuøng ñieàu khieån Control zone on/off: CONZ_ON 

-  Ñoä roäng vuøng Control zone:  CON_ZONE 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 5.13. Ñoà thò keát quaû cuûa quaù trình caäp nhaät thoâng soá 

 

Ví duï veà laøm giaûm ñaùp öùng ñieàu khieån vôùi PFAC_SP 

Thoâng soá quaù trình: 

GAIN =  6 

T1       = 50s 

T2       = 5s 

Thoâng soá boä ñieàu khieån: 
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GAIN =  6 

TI       = 19.6s 

 

 

Baûng 5.2: Chuù thích keát quaû cuûa ñoà thò 

 

 

 

 

 

 

 

 

 

 

5.2.2 Caùc thoâng soá cuûa FB58 

 

ÑÒA 

CHÆ 

THOÂNG 

SOÁ 

IN/OUT KIEÅU 

DÖÕ 

LIEÄU 

VUØNG 

GT 

GT 

ÑAÀU 

MOÂ TAÛ 

0.0 PV_IN INPUT REAL Tuyø 

caûm 

bieán söû 

duïng 

0.0 PROCESS VARIABLE 

IN. 

 Giaù trò khôûi taïo coù theå 

ñaët ôû ñaàu vaøo”process 

variable on” hoaëc  ë töø 

bieán quaù trình ñöôïc 

bieåu dieãn döôùi daïng soá 

thöïc daáu phaûy ñoäng 

4.0 PV_PER INPUT INT  0 PROCESS VARIABLE 

PERIPHERY 

Bieán quaù trình ñöôïc noái 

vôùi CPU thoâng qua 

coång vaøo töông töï. 

6.0 DISV INPUT REAL  0.0 DISTURBANCE 

VARIABLE  

Ñoái vôùi ñieàu khieån 

thuaän bieán nhieãu seõ 

Thôøi 

gian 

thöû 

Heä soá 

SP 

Chuù thích Ñoä voït loá 

     8:18 1.0 Cô caáu P khoâng coù söï hoài tieáp 32% 

     8:19 0.8 Cô caáu P coù söï hoài tieáp 20%, söï 

ñaùp öùng ñieàu khieån ôû ñieàu kieän 

toát nhaát 

2% 

     8:20 0.0 Cô caáu P hoài tieáp hoaøn toaøn, söï 

chaán ñoäng giaûm maïnh. 

- 
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ñöôïc noái ôû ngoõ vaøo 

disturbance variable 

10.0 INT_HPO

S 

INPUT BOOL  FALS

E 

INTEGRAL ACTION 

HOLD IN POSITIVE 

DIRECTION .  

Ngoõ ra cuûa cô caáu I coù 

theå ñöôïc chæ ra trong 

moät phaïm vi tröïc tieáp. 

Ñeå ñaït ñöôïc ñieàu naøy, 

ngoõvaøo INT_HPOS 

phaûi ñöôïc set ñeán giaù 

trò TRUE . Trong töøng 

ñôït ñieàu khieån, 

INT_HPOS cuûa boä ñieàu 

khieån ñaàu tieân ñöôïc keát 

noái ñeán ngoõ 

QLMN_HLM cuûa boä 

ñieàu khieån thöù 2 

10.1 INT_HNE

G 

INPUT BOOL  FALS

E 

INTEGRAL ACTION 

HOLD IN NEGATIVE 

DIRECTION. 

 Ngoõ ra cuûa cô caáu I coù 

theå ñöôïc chæ ra trong 

moät höôùng phuû ñònh. 

Ñeå ñaït ñöôïc ñieàu naøy 

,ngoõ vaøo INT_HPOS 

phaûi ñöôïc set ñeán giaù 

trò TRUE . Trong töøng 

ñôït ñieàu khieån, 

INT_HPOS cuûa boä ñieàu 

khieån ñaàu tieân ñöôïc keát 

noái ñeán ngoõ 

QLMN_LLM cuûa boä 

ñieàu khieån thöù 2 

12.0 SELECT INPUT INT 0ÑEÁN 

3 

0 SELECTION OF CALL 

PID AND PULSE 

GENERATOR. 
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Neáu maùy phaùt sung 

ñöôïc kích hoaët, coù moät 

vaøi caùch ñeå goïi thuaät 

toaùn PID vaø boä phaùt 

sung. 

SELECT =0: Boä ñieàu 

khieån seõ ñöôïc goïi trong 

moät chu kì nhanh ôû möùc 

ñoä giaùn ñoaïn, thuaät toaù 

PID vaøø boä phaùt sung seõ 

ñöôïc xöû lí. 

SELECT =1:Boä ñieàu 

khieån seõ ñöôïc goïi trong 

khoái OB1 vaø chæ thuaät 

toaùn PID ñöôïc xöû lí. 

SELECT = 2: boä ñieàu 

khieån seõ ñöôïc goïi trong 

moät chu kì nhanh ôû möùc 

ñoä giaùn ñoaïn vaø chæ boä 

phaùt sung ñöôïc xöû lí. 

SELECT =3: Boä ñieàu 

khieån seõ ñöôïc goïi trong 

moät chu kì chaäm ôû möùc 

ñoä giaùn ñoaïn vaø chæ 

thuaät toaùn PID ñöôïc xöû 

lí. 

14.0 PV OUTPU

T 

REAL Tuyø 

caûm 

bieán söû 

duïng 

0.0 PROCESS VARIABLE 

Tín hieäu quaù trình ñöôïc 

xuaát qua coång ra 

“process variable” 

18.0 LMN OUTPU

T 

REAL  0.0 MANIPULATED 

VARIABLE 

Giaù trò ra ñöôïc thieát laäp 

baèng tay thoâng qua 

coång ra” manipulated 

variable” 

22.0 LMN_PER OUTPU INT  0 MANIPULATED 
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T VARIABLE 

PERIPHERY. 

Giaù trò ñaàu ra thieát laäp 

baèng tay theo kieåu bieåu 

dieãn phuø hôïp vôùi caùc 

coång vaøo/ra töông töï 

ñöôïc choïn qua ngoõ 

ra“manipulated variable 

periphery” 

24.0 QPULSE OUTPU

T 

BOOL  FALS

E 

OUTPUT PULSE 

SIGNAL. 

Khi coù giaù trò xung 

ñöôïc kích hoaët thì seõ coù 

tín hieäu ra taïi ngoõ ra 

“QPULSE” 

24.1 QLMN 

HLM 

OUTPU

T 

BOOL  FALS

E 

HIGH LIMIT OF 

MANIPULATED 

VARIABLE 

REACHED. 

Coång ra” hight limit of 

manipulated variable 

reached ” thoâng baùo giaù 

trò cuûa bieán quaù trình 

vöôït quaù giaù trò giôùi 

haïn 

24.2 QLMN_LL

M 
OUTPU

T 

BOOL  FALS

E 

LOW LIMIT OF 

MANIPULATED 

VARIABLE 

REACHED  

Coång ra” low limit of 

manipulated variable 

reached ” thoâng baùo 

giaù tò cuûa bieán quaù trình 

nhoû hôn giaù trò giôùi haïn  

24.3 QC_ACT OUTPU

T 

BOOL  TRUE NEXT CYCLE, THE 

CONTINUOUS 

CONTROLLER IS 
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WORKING. 

Thoâng soá naøy seõ ñöôïc 

chæ roõ khi coù hay khoâng 

traïng thaùi ñieàu khieån 

tieáp theo seõ ñöôïc thi 

haønh taïi laàn goïi tieáp 

theo (chæ thích hôïp khi 

SELECT coù giaù trò 1 

hoaëc 0) 

26.0 CYCLE INPUT/ 

OUTPU

T 

REAL 0.001

s 

0.1s SAMPLE TIME  OF 

CONTINUOUS 

CONTROLLER[s]. 

Taïi ñaây seõ set thôøi gian 

maãu ñoái vôùi thuaät toaùn 

PID. Boä ñieàu chænh 

trong pha thöù nhaát vaø 

ñöa vaøo CYCLE. Thôøi 

gian laáy maãu laø khoaûng 

thôøi gian khoâng ñoåi 

giöõa caùc laàn khoái ñöôïc 

caäp nhaät. 

30.0 CYCLE_P INPUT/ 

OUTPU

T 

REAL 0.001

s 

0.02s SAMPLE TIME  OF 

PULSE 

GENERATOR[s]. 

Taïi ngoõ vaøo naøy, baïn 

ñöa vaøo thôøi gian maãu 

ñoái vôùi maùy phaùt xung. 

FB 58 “TCONT_CP” 

tính toaùn thôøi gian maãu 

trong pha thöù nhaát vaø 

ñöa noù vaøo trong 

CYCLE_P. 

34.0 SP_INT INPUT/ 

OUTPU

T 

REAL vuøng 

giaù trò 

cuûa giaù 

trò xöû lí 

0.0 INTERNAL 

SETPOINT 

Ñaàu vaøo “internal 

setpoint” ñöôïc söû duïng 

ñeå thieát laäp tín hieäu chuû 
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ñaïo. 

38.0 MAN INPUT/ 

OUTPU

T 

REAL  0.0 MANUAL VALUE.  

Coång vaøo” manual 

value” ñöôïc söû duïng ñeå 

ñaët giaù trò baèng caùc 

haøm giao dieän  

42.0 COM_RST INPUT/ 

OUTPU

T 

BOOL  FALS

E 

COMPLETE 

RESTART 

Khoái coù chöùc naêng khôûi 

taïo laïi heä thoáng hoaøn 

toaøn khi ñaàu vaøo 

“complete restart” ñöôïc 

thieát laäp giaù trò logic 

TRUE 

42.1 MAN_ON INPUT/ 

OUTPU

T 

BOOL  TRUE MANUAL 

OPERATION ON. 

Khi ñaàu vaøo “manual 

operation on” coù giaù trò 

logic TRUE maïch voøng 

ñieàu khieån seõ bò ngaét, 

caùc giaù trò seõ ñöôïc thieát 

laäp baèng tay. 

90.0 PVPER_O

N 

INPUT BOOL  FALS

E 

PROCES VARIABLE 

PERIPHERY ON 

Neáu baïn muoán giaù trò 

xöû lí ñöôïc ñoïc thoâng 

qua thieát bò I/O, ngoõ 

vaøo PV_PER phaûi ñöôïc 

keát noái ñeán I/O vaø giaù 

trò xöû lí ngoaïi vi phaûi 

ñöôïc set leân (TRUE).  

186.5 LOAD_PI

D 

INPUT/ 

OUTPU

T 

BOOL  FALS

E 

LOAD OPTIMIZED 

PI/PID PARAMETERS 

 

186.6 PID_ON INPUT/ 

OUTPU

T 

BOOL  FALS

E 

PID MODE ON 

PID controller: 

PID_ON = TRUE 

Truong DH SPKT TP. HCM http://www.hcmute.edu.vn

Thu vien DH SPKT TP. HCM - http://www.thuvienspkt.edu.vn

Ban quyen © Truong DH Su pham Ky thuat TP. HCM

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


 Trang 72  

PI controller: 

PID _ON = FALSE 

 

 

 

5.3 HAØM FC105, FC106 

Ñeå thuaät lôïi trong quaù trình xöû lyù caùc tín hieäu töông töï phaàn meàm Step 7 coù saün 

haøm thö vieän FC105,FC106  

5.3.1 Haøm FC105_Ñònh tæ leä gía trò ngoõ vaøo Analog 

 

 

 

 

 

 

 

                    Hình 5.14. Caùc caâu leänh cuûa haøm FC105 

 

- Ví duï: Möùc ñaày trong boàn ñöôïc ño baèng lít .Boä 

chuyeån ñoåi ño ñöôïc choïn 500 lít  thì töông öùng        

vôùi moät giaù trò ño laø 10V. 

- Tæ leä: Module Analog chuyeån ñoåi giaù trò analog 

10V thaønh soá nguyeân 27 648. Giaù trò naøy baây 

giôø ñaõ ñöôïc chuyeån ñoåi thaønh ñaïi löôïng vaät lí lít. 

Quaù trình naøy ngöôøi ta goïi laø ñònh tæ leä giaù trò 

Analog.  

- Chöông trình:Vieäc ñònh tæ leä giaù trò analog ñöôïc 

thöïc hieä trong khoái chuaån FC 105. Khoái FC 105 naèm trong thö vieän “ 

Standard Library”trong chöông  trình S7”TI-S7 Converting Block” cuûa 

phaàn meàm Step 7. 

- IN    : Giaù trò Analog taïi ngoõ vaøo IN coù theå ñöôïc ñoïc tröïc tieáp töø module 

hoaëc 

    ñoïc qua ngoõ giao tieáp döõ lieäu trong daïng INTEGR 

- LO_LIM,HI_LIM: Caùc giôùi haïn chuyeån ñoåi caùc ñaïi löông vaät lí seõ ñöôïc 

ñaët 

tröôùc ôû caùc ngoõ vaøo LO_LIM (giôùi haïn döôùi) vaø HI_LIM (giôùi haïn 

treân). Trong thí duï treân thì giôùi haïn chuyeån ñoåi töø 0 ñeán 500 lít. 
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- OUT: Giaù  trò tæ leä (ñaïi löôïng vaät lí) thì ñöôïc löu tröõ  nhö laø moät soá thöïc taïi 

ngoõ 

      ra OUT. 

 
Haèng soá K1, K2 seõ ñöôïc set döïa treân giaù trò ngoõ vaøo laø BIPPOLAR hay 

UNBIPPOLAR 

- BIPPOLAR:  Ngoõ vaøo BIPPOLAR xaùc ñònh lieäu giaù trò aâm coù ñöôïc 

chuyeån ñoåi 

      hay khoâng. 

BIPPOLAR: Giaù trò ngoõ vaøo laø soá nguyeân ñöôïc thöøa nhaän giöõa -27648 

vaø +27648,do ñoù K1 laø -27648, K2  laø +27648. 

UNBIPPOLAR: Giaù trò ngoõ vaøo laø soá nguyeân ñöôïc thöøa nhaän giöõa 0 

vaø +27648,do ñoù K1 laø0, K2  laø +27648. 

Trong ví duï treân, bit nhôù 0.0 coù tín hieäu “0” vaø vì theá baùo hieäu giaù trò ngoõ 

vaøo laø moät cöïc.  

- RET_VAL: Ngoõ ra RET_VAL coù giaù trò 0 neáu söï hoaët ñoäng khoâng coù söï 

coá. 

       Neáu giaù trò taïi ngoõ vaøo lôùn hôn K2 , ngoõ ra OUT ñöôïc  kieåm soaùt bôûi 

HI_LIM vaø loãi xuaát hieän, neáu giaù trò taïi ngoõ vaøo nhoû hôn K1 , ngoõ ra OUT 

ñöôïc  kieåm soaùt bôûi LO_LIM vaø loãi xuaát hieän. Luùc naøy ENO seõ ñöôïc set 

giaù trò 0, vaø RET_VALseõ coù giaù trò W#16#0008. 

 

5.3.2 Haøm FC106_Khoâng chia tæ leä soá thöïc cho ngoõ ra Analog 

 

 

 

 

 

 

 

 

 

 

 

Hình 5.15. Caùc caâu leänh cuûa haøm FC106 
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Ví duï: Chöông trình tính toaùn giaù trò Analog 

trong 

phaïm vi töø 0 ñeán 100.0%. Giaù trò naøy ñöôïc 

chuyeån tôùi ngoõ ra nhôø moät module ngoõ ra 

Analog. 

- Khoâng chia tæ leä: Khoái chuaån FC106 ñöôïc söû 

duïng 

cho vieäc khoâng chia tæ leä (söï bieán ñoåi cuûa moät 

soá thöïc töø 0 ñeán 100.0% thaønh moät soá nguyeân 

16 bits töø 0 ñeán 27648) 

- OUT:Giaù trò Analog khoâng chia tæ leä taïi ngoõ ra out coù theå ñöôïc tryeàn ñi 

döôùi 

daïng moät soá nguyeân 16 bits ñeán ngoõ giao tieáp döõ lieäu hoaëc tröïc tieáp ñeán 

ngoaïi vi. 

Chöông trình: Khoái FC106 naèm trong thö vieän “Standard Library” trong chöông 

trình S7 “TI-S7 Converting Block” cuûa phaàn meàm Step7. 

 

5.4 Ví duï öùng duïng ñieàu khieån möùc nöôùc trong boàn 

5.4.1  Nguyeân Lyù hoaït ñoäng : 

 Nöôùc ñöôïc  bôm töø  bình chöùa 1 leân bình 2 baèng bôm ly taâm ,bôm ly taâm 

hoaït ñoäng theo hai cheá ñoä coù theå ñieàu khieån baèng tay hoaëc ñieàu khieån töø PLC 

baèng nuùm chuyeån hai cheá ñoä AUTO vaø MAN, bôm hoaït ñoäng ôû hieäu ñieän theá 

xoay chieàu 220-240 VAC ,coâng suaát laø 30 W, löu  löôïng nöôùc khoaûng 20 

lít/phuùt, noù ñöôïc taùc ñoäng bôûi 2 rôle(250 VAC/5A). Doøng nöôùc qua bôm chia 

laøm 2 phaàn, 1 löôïng seõ qua van solenoid vaø 1 löôïng ñöôïc hoài veà beå 1 ñeå baûo 

ñaûm an toaøn cho bôm khi van solenoid ñoùng laïi. Van solenoid cuõng coù theå ñöôïc 

ñieàu khieån baèng tay hoaëc baèng PLC duøng ñeà ñoùng môû  töùc thôøi doøng nöôùc leân 

boàn chöùa 1 khi ñieàu khieån. Aùp suaát hoaït ñoäng töø  0-10 bar, caáp doøng 24 VDC, 

doøng coù theå ñöôïc caáp töø rôle  hoaëc tröïc tieáp töø  PLC. 

 

Doøng tieáp tuïc qua boä phaän hieån thò löu löôïng  doøng cô khí duøng ñeå ñieàu chænh 

löu löôïng sao cho vöøa phaûi oån ñònh giöõa 2 luoàng nöôùc phaân nhaùnh töø bôm. Khi qua boä 

chuyeån ñoåi löu löôïng  boä phaän naøy seõ hieån thò giaù trò löu löôïng doøng chaûy chính xaùc 

vaø truyeàn thoâng soá naøy veà cho PLC xöû lyù döôùi daïng doøng ñieän töø  0/4 – 20 mA tuyø 

theo giaù trò lôùn nhoû cuûa löu  löôïng nöôùc. 

 

PLC nhaän 2 ngoõ vaøo analog laø boä chuyeån ñoåi löu löôïng vaøø caûm bieán, tuyø thuoäc vaøo 

chöông trình phaàn meàm ñieàu khieån ñöôïc vieát saün maø PLC seõ ñieàu khieån  proportional 
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vale( vale ñieàu khieån tyû leä ) ñeå ñoùng môû goùp môû  cuûa van . Do ñoù  löu löôïng nöôùc seõ 

ñöôïc ñieàu khieån 1 caùch tyû leä vôùi doøng maø PLC  xuaát ra töø ngoõ ra AO. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 5.16. Sô ñoà khoái ñieàu khieån möùc nöôùc. 

 

 5.4.2 Sô ñoà khoái cuûa heä thoáng töï ñoäng  

  

 

 

 

 

 

 

 

 

 

 

 

Hình 5.17. Sô ñoà khoái cuûa heä thoáng töï ñoäng 

P S C P U D I D O A O AI

BO Ä Ñ O  M ÖÙC

BO Ä

Ñ O

L Ö ÔÏN G

V 3
O N /O FF

BÔ M

V 2 (0% -100 % )
Va n tuye án  tính

LIS 1

V 1
ON /OFF

4
-2

0
m

A

P Q W 288 P IW 272

S ta rt /

S top

I0
.0

I0
.1

4
-2

0
m

A
1

-1
0

0
c

m

V 4
V an xa û

Bo àn  1

B oàn  2

Q
0.

2

Q
0

.1

PVFuzzy
control

Boàn nöôùc 2

Caûm bieán

-

SP

N

+ + +
ess

PID 

(FB58) 

Caûm bieán 

ño möùc 
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PID control: ñöôïc ñieàu khieån thoâng qua cuïc PLC  
Boàn nöôùc 2: laø ñoái töôïng ñieàu khieån  

Caûm bieán ño : caûm bieán ño möùc nöôùc döïa vaøo aùp löïc ñeø leân beà maët töø 0 – 0.1 bar ñeå 

ñöa ra doøng vaø aùp töông öùng töø  4-20mA  

Tín hieäu nhieãu ess  do taùc ñoäng cuûa van xaû  

Trong  ñoù : SP :  laø giaù trò töï  nhaäp vaøo  (ñöôïc nhaäp vaøo töø beân ngoaøi ). 

PV : laø giaù trò hieän taïi coù trong boàn nöôùc (giaù trò ñöôïc  ñoïc töø vuøng nhôù vaøo analog) 

Ta laáy giaù trò hieän taïi PV so vôùi giaù trò ñöa vaøo SP  ta ñöôïc  ess = SP-PV  

Sô ñoà ñieàu khieån  

 

 

 

 

  

5.4.3. Khai Baùo Thoâng Soá Phaàn Cöùng: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 5.18. Khai baùo phaàn cöùng cho traïm PLC  

 

Slot 1
Nguoàn 230VAC

-  24VDC
PS  307 5A
6ES7 307 -

1EA00-0AA0

Slot 2 vaø slot 3
CPU 315
(S7-300)

CPU 315- 2DP
6ES7 315 -

2AF03-0AB0-
V1.2

Slot 4
8DI/D0 x 24V/

0.5A
6ES7 323 -

1BH00-0AA0

Slot 5
AI 2x 12 bit
(4-20 mA)
6ES7 331-

7KB02-0AB0

Slot 6
A0 2x 12 bit
(4-20 mA)
6ES7 332 -

5HB01-0AB0

AI
A/D IN

4-20 mA

Vuøng
nhôù

Soá thöïc Soá thöïc

PIW PQW

A0
D/A

FC105 FB 30 FC106
Tín hieäu

ra

FB58 
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Baûng ñòa chæ vaøo ra 

 

Ñòa Chæ Teân thieát bò 

I0.0 S1 Nuùt Start/Stop 

I0.1 LIS1 Caûm bieán phaùt hieän ngöôõng treân 

Q0.0 Ñeøn baùo traïng thaùi Start/ Stop 

Q0.1 Van V3 vaø Bôm 

Q0.2 Van V1 

AI 0 LIS1 Caûm bieán ño möùc 4…20mA 

AI 1  FIS1 Caûm bieán ño löu löôïng 4…20mA 

AO 0 V2 Van tuyeán tính 

 

Phaàn meàm ñieàu khieån 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

OB1: 

Network 1 

A     "Start/Stop push button" 

FN    M      0.0 

S     "Start/Stop push lamp" 

S     "Pump_Valve3" 
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Network 2 

A     "Level_Switch" 

      =     "V1" 

 

Network3 

// Lay gia tri hien thoi cua level  

 

      CALL  "SCALE" 

       IN     :=MW10 

       HI_LIM :=1.000000e+002 

       LO_LIM :=0.000000e+000 

       BIPOLAR:=FALSE 

       RET_VAL:=MW12 

       OUT    :="Curr_Level" 

 

      L     "Curr_Level" 

      T     "db58".PV_IN 

 

// Lay SP cua PID Controller 

 

 

      L     "Level_SP" 

      T     "db58".SP_INT 

 

      CALL  "TCONT_CP" , "db58" 

       PV_IN   := 

       PV_PER  := 

       DISV    := 

       INT_HPOS:= 

       INT_HNEG:= 

       SELECT  :=1 

       PV      := 

       LMN     := 

       LMN_PER := 

       QPULSE  := 

       QLMN_HLM:= 
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       QLMN_LLM:= 

       QC_ACT  := 

       CYCLE   := 

       CYCLE_P := 

       SP_INT  := 

       MAN     := 

       COM_RST := 

       MAN_ON  := 

 

      L     "db58".LMN_PER 

      T     "Proportional_Valve" 

 

 

 

// Lay % do mo vua Van V2 

 

      L     "db58".LMN 

      T     "Op_Per_V2" 

 

Network 4 

 

   A     "db58".PID_ON 

   S     M      0.2 

   S     "db58".LOAD_PID 

 

Network 5 

 

A     "Start/Stop push lamp" 

A     "Start/Stop push button" 

FN    M      0.1 

 R     "Start/Stop push lamp" 

 R     "Pump_Valve3" 

 

 

OB100: 

 

Network1: 
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SET    

      R     "db58".MAN_ON 

      R     "db58".PVPER_ON 

 

DB58: 
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